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34 Englisch

HELLOMOTO

Kompakte Form, modernes Design und 
optimaler Sound! Das MOTO™ U9-Mobiltelefon 
kann sich sehen lassen und lädt zum Anfassen 
ein!

• Spielen Sie Ihre Lieblingsmusik schnell 
und unkompliziert auf Ihrem Telefon dank 
des Media Player 11 von Microsoft® 
Windows®. Mit dem Media Player 11 von 
Microsoft® Windows® können Sie Songs 
aus Online-Musikstores herunterladen und 
auf Ihr Telefon übertragen. Der Speicher 
kann auf 4 GB erweitert werden und somit 
bis zu 20 Stunden Musik bereitstellen. 
Steuern Sie die Musikwiedergabe durch 
Berühren der Tasten auf dem externen 
Display (Informationen hierzu finden Sie in 
der Kurzanleitung).

• Geben Sie Ihrem Telefon mit animierten 
Screensavern auf dem externen Display 
eine ganz persönliche Note (Informationen 
hierzu finden Sie in der Kurzanleitung).

• Mit der 2-Megapixel-Multishot-Kamera 
können Sie Bilder automatisch aufnehmen 
(Seite 53).

• Öffnen Sie eine Website Ihrer Wahl, ganz 
genauso wie mit dem Computer. 
Verwenden Sie dazu den voll 
funktionsfähigen HTML-Browser des 
Telefons (Seite 51).

• Rufen Sie Ihre persönlichen E-Mail-Konten 
(wie Hotmail, Gmail oder Yahoo) über das 
Internet ab (Informationen hierzu finden 
Sie in der Kurzanleitung). Oder lesen und 
synchronisieren Sie Ihre E-Mails (Microsoft 
Outlook) mit MOTOSYNC (Seite 67).

• Lassen Sie Ihr Telefon Textnachrichten, 
Informationen zu eingehenden Anrufen 
sowie Menüoptionen vorlesen (Seite 32).

• Ihr Telefon ist mit 
Stereo-Bluetooth-Funktion ausgestattet 
und bietet Ihnen damit noch mehr 
Flexibilität (Seite 72).

U9.EMEA.Asia.UG.book  Page 1  Friday, January 4, 2008  3:13 PM



2

34 Englisch
Weitere Informationen: Drücken Sie Hauptmenü 
> m Tools > Hilfe, um im Telefondisplay 
Anweisungen zu den Funktionen anzuzeigen. 
Lernprogramme im Internet und weitere 
Informationen zu Telefon und Zubehör finden 
Sie im Internet unter www.hellomoto.com.
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34 Englisch
Hier eine Einführung zu Ihrem MOTO™ U9 GSM-Mobiltelefon. Die folgenden Abbildungen zeigen 
wichtige Komponenten und Bedienelemente des Mobiltelefons.

Akku-Ladeanzeige

Lautstärketasten

Seitliche
Auswahltaste

Micro-USB-Anschluss Externes Display

Kameraobjektiv Öse für Tragriemen
(oben am Telefon)

Bluetooth®-LED

Sprachsteue-
rungstaste

Freisprechein-
richtung
(auf der Rückseite 
des Telefons)
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Hinweis: Dies ist das Standardlayout des Standby-Displays und des Hauptmenüs. Das 
Standby-Display und das Hauptmenü Ihres Telefons können unter Umständen von dieser Abbildung 
abweichen. In der Kurzanleitung finden Sie Informationen zum Ändern der Belegung der 
Schnellzugriffstasten und der Hauptmenüansicht.

4

31

2

Halten Sie zum 
Einschalten des 
Telefons die 
Einschalttaste P 
gedrückt, bis das 
Display aufleuchtet.

Drücken Sie die mittlere 
Taste s, um das 
Hauptmenü zu öffnen.

Drücken Sie 
die 
Navigations-
taste S 
oben/unten
/rechts/links, 
um zu einem 
Menüeintrag 
zu blättern.

Drücken Sie 
die mittlere 
Taste s, um 
den Eintrag 
auszuwählen.

Standby-Display Hauptmenü

Diensteanbieter 10:10

15/10/2008
Schn.tast. Hauptmenü Optionen

Kontakte
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 Bestimmte Funktionen des Mobiltelefons sind 
von den Möglichkeiten und Einstellungen des 
Diensteanbieters abhängig. Darüber hinaus 
wurden manche Funktionen vom 
Diensteanbieter möglicherweise nicht aktiviert 
und/oder sind bedingt durch die 
Netzwerkeinstellungen nur eingeschränkt 
nutzbar. Bitte wenden Sie sich mit Fragen zu 
Verfügbarkeit und Leistungsumfang von 
Funktionen an Ihren Diensteanbieter. Alle in 
dieser Bedienungsanleitung enthaltenen 
Informationen zu Funktionen, Leistungsumfang 
und anderen Produkteigenschaften basieren auf 
den aktuellsten Informationen und sind zum 
Zeitpunkt der Drucklegung nach bestem Wissen 
korrekt. Motorola behält sich das Recht vor, 
Informationen oder technische Daten ohne 
vorherige Ankündigung und ohne weitere 
Verpflichtungen zu ändern.
MOTOROLA und das stilisierte M-Logo sind 
beim US Patent & Trademark Office eingetragen. 
Die Bluetooth-Marken gehören dem jeweiligen 
Eigentümer und werden von Motorola, Inc. 
unter Lizenz verwendet. Java und alle anderen 
Java-basierten Marken sind Marken oder 
eingetragene Marken von Sun Microsystems, 
Inc. in den USA und anderen Ländern. Microsoft 
und Windows sind eingetragene Marken der 
Microsoft Corporation, und Windows XP und 
Windows Media sind Marken der Microsoft 
Corporation. Macintosh ist eine eingetragene 
Marke von Apple Computer, Inc. Die Namen aller 
anderen Produkte oder Dienstleistungen sind 
Eigentum ihrer jeweiligen Inhaber.
© Motorola, Inc., 2007.

Hinweis: Nicht explizit von Motorola 
genehmigte Änderungen oder Modifikationen 
am Mobiltelefon führen zum Erlöschen der 
Betriebserlaubnis des Benutzers.
Software-Copyright-Hinweis 
Die in diesem Handbuch beschriebenen 
Motorola Produkte enthalten möglicherweise 
Motorola Software oder Software anderer 
Hersteller, die in Halbleiterspeichern oder 
sonstigen Medien gespeichert und 
urheberrechtlich geschützt sind. Durch Gesetze 
in den USA und anderen Ländern werden 
Motorola, Inc. und unabhängigen 
Software-Herstellern Exklusivrechte an der 
urheberrechtlich geschützten Software, 
einschließlich der Exklusivrechte zum Verteilen 
und Reproduzieren der urheberrechtlich 
geschützten Software, gewährt. Demzufolge 
darf urheberrechtlich geschützte Software, die in 
den Produkten von Motorola enthalten ist, nur 
im gesetzlich zugelassenen Umfang geändert, 
zurückentwickelt, verteilt oder reproduziert 
werden. Darüber hinaus werden durch den Kauf 
von Motorola-Produkten weder direkt, 
stillschweigend, kraft Rechtsscheins noch 
anderweitig Lizenzrechte im Rahmen der 
Urheberrechte, Patente oder 
Patentanmeldungen von Motorola oder eines 
Software-Drittanbieters, ausgenommen der 
normalen, einfachen und gebührenfreien Lizenz 
zur Nutzung des Produkts, die kraft Gesetzes 
beim Kauf eines Produkts gewährt wird, 
gewährt.
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34 Englisch

Menüübersicht
Hauptmenü   
A Wecker

1 Web-Zugriff
• Browser
• Bookmarks
• Meine Webseiten
• Verlauf
• Gehe zu URL
• Browser-Setup

T Spiele

m Tools
• Kalender
• E-Mail
• Weltuhr
• SIM-Anwendungen *
• MOTOSYNC
• Rechner
• Download-Manager
• Datei-Manager

• Speicherkarte *
• MMSIM *
• Musik und Töne
• Bilder
• Videos
• Sprachmemo
• Applikationen
• Unerkannte Dateien
• Meine Dokumente
• tmp

• IM *
• Wähldienste
• Aufgabenliste
• Notizen
• Hilfe

g Nachrichten
• Nachricht erstellen
• Eingang
• Meine Ordner
• Vorlagen
• Entwürfe
• Ausgang
• Postkarte erstellen *
• E-Mail
• Mailbox anrufen

L Kontakte

q Anrufliste

j Multimedia
• Media Finder
• Kamera
• Videokamera
• Voice Recorder

u Setup
• (siehe nächste Seite)

 
Dies ist das Standardlayout des 
Hauptmenüs. Das Menü Ihres 
Mobiltelefons kann unter 
Umständen von dieser 
Abbildung abweichen.
Informationen zum Ändern der 
Belegung der 
Schnellzugriffstasten und der 
Hauptmenüansicht finden Sie 
in der  Kurzanleitung.
Tipp: Drücken Sie D, um das 
aktuelle Menü zu beenden, 
oder O, um alle Menüs zu 
beenden.
 
* Optionale Funktionen
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34 Englisch

Setup-Menü   
• Profile

• Themes

• Standby-Display
• NaviKey-Schnellzugriff
• Wallpaper änd.
• Externer Uhrenstil

• Verbindungen
• Bluetooth®

• USB-Einstellung
• Mediadatei-Sync
• Speicherkarte
• Modem
• USB-Druck

• Sprachnetzwerke *
• Voice over IP *
• Netzwerkeinstell. *

• Datenverbindungen
• Neue Verbindung
• Verbind. bearbeiten
• Verbindung löschen

• Anrufe
• Kurzwahl
• Anrufumleitung
• Gesprächsoptionen

• Hörhilfe *
• Meine Anrufer-ID
• Gesprächstimer
• Rufannahme
• Nachrichtenalarm
• Roaming-Signal
• Anklopfen
• Auto. Wahlwiederhlg.
• Rufabbruchton

• Wahl-Setup
• Meine Anrufer-ID
• DTMF *
• Suchmodus *
• Wähle Vorwahl

• Anrufsperre *
• Feste Rufnummern
• Eigene Rufnummer
• Aktive Leitung *

• Telefon
• Display

• Timeout Display
• Screensaver
• Helligkeit

• Flugzeugmodus
• Akkuladezustand
• Uhrzeit & Datum
• (Fortsetzung in nächster Spalte)

• Telefon (Fortsetzung)
• Sprache
• Sprachmodus
• Texteingabe
• Zurücksetzen

• Alle Einst. zurückset.
• Alle Daten löschen
• Speicherkarte löschen

• Speicher anzeigen
• Eigenschaften
• Java-System
• Rechtliche Hinweise
• OTA-Updates
• Headset-Einst.

• Auto-Antwort
• Sprachwahl

• Sicherheit
• Telefonsperre
• Externe Tastensperre
• Anwendungssperre
• SIM-PIN
• Passwörter ändern
• Zertifikate

• Netz
• Aktuelles Netz
• Netze scannen
• Neues Netz suchen
• Meine Netzliste
• Netzsuche einricht.
• Dienstton

 
* Optionale Funktionen
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Sicherheitsrelevante und allgemeine 
Informationen
SicherheitsinformationenDieser Abschnitt enthält wichtige Informationen 
für einen sicheren und effizienten Betrieb Ihres 
Mobilgeräts. Lesen Sie diese Informationen, 
bevor Sie Ihr Mobilgerät verwenden.1

Belastung durch 
elektromagnetische Strahlung 
im Radio-Frequenzbereich (RF 
= Radiofrequenz)
Ihr Mobilgerät verfügt über einen Sender und 
Empfänger. Wenn das Gerät EINGESCHALTET ist, 
überträgt und empfängt es Radio-Frequenzwellen. 
Während der Kommunikation regelt Ihr mobiles 
Gerät die Übertragungsleistung.
Ihr Motorola Mobilgerät wurde so entwickelt, dass 
es die behördlichen Anforderungen Ihres Landes 
hinsichtlich der RF-Belastung für Personen einhält.

Vorsichtsmaßnahmen für den 
Betrieb
Um einen optimalen Betrieb Ihres Mobilgeräts und 
die Einhaltung der RF-Emissionswerte gemäß den 
Richtlinien der entsprechenden Standards zu 
gewährleisten, beachten Sie die nachfolgenden 
Hinweise und Vorsichtsmaßnahmen.

Wartung der externen Antenne
Falls Ihr mobiles Gerät über eine externe Antenne 
verfügt, verwenden Sie nur die mitgelieferte bzw. 
bei Bedarf eine von Motorola genehmigte 
Ersatzantenne. Nicht zugelassene Antennen, 
Änderungen oder Zusatzgeräte können das 
Mobilgerät beschädigen und/oder dazu führen, 
dass die Benutzung Ihres Gerätes gegen 
gesetzliche Vorschriften in Ihrem Land verstößt.
BERÜHREN SIE DIE EXTERNE ANTENNE NICHT, 
wenn das Mobilgerät VERWENDET wird. Das 
Berühren der externen Antenne beeinflusst die 
Qualität der Gesprächsverbindung und kann unter 
Umständen zu einem erhöhten Energieverbrauch 
des Mobilgeräts führen.

Betrieb des Produkts
Halten Sie Ihr Mobilgerät beim Telefonieren genau 
so, wie Sie auch ein schnurloses Festnetztelefon 
halten würden.

1. Die in diesem Dokument bereitgestellten 
Informationen ersetzen die Allgemeinen 
Sicherheitsinformationen in allen 
Benutzerhandbüchern, die vor dem 
1. Mai 2007 veröffentlicht wurden.
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Wenn Sie das Mobilgerät am Körper tragen, 
platzieren Sie das Mobilgerät immer in einem von 
Motorola gelieferten oder zugelassenen Clip, einer 
Halterung, einem Halfter, einer Hülle oder einem 
Tragegurt. Wenn Sie kein von Motorola geliefertes 
oder zugelassenes Zubehör für das Tragen am 
Körper nutzen – oder wenn Sie Ihr Mobilgerät an 
einem Band um den Hals gehängt haben –, halten 
Sie das Mobilgerät und seine Antenne beim 
Senden mindestens 2,5 Zentimeter vom Körper 
entfernt.
Wenn Sie eine Datenfunktion Ihres Mobilgerätes 
nutzen, mit oder ohne Zubehörkabel, halten Sie 
das Mobilgerät und seine Antenne mindestens 2,5 
Zentimeter vom Körper entfernt.
Das Benutzen von nicht von Motorola 
zugelassenem Zubehör kann zum Überschreiten 
der in den gesetzlichen Vorschriften festgelegten 
Grenzwerte für die Belastung durch RF-Energie 
führen. Eine Liste der von Motorola gelieferten 
oder zugelassenen Zubehörteile finden Sie auf der 
Website von Motorola unter www.motorola.com.

Radio-Frequenzwellen-
Interferenz/Kompatibilität
Fast alle elektronischen Geräte sind bei 
unzureichender Abschirmung, fehlerhafter 
Konstruktion oder konstruktionsbedingt anfällig 
für RF-Interferenzen. Unter bestimmten 
Umständen kann Ihr Mobilgerät Interferenzen mit 
anderen Geräten verursachen.

Befolgen Sie die Anweisungen, 
um Probleme durch Interferenzen zu 
vermeiden
Schalten Sie Ihr Mobilgerät aus, sobald Sie durch 
entsprechende Hinweisschilder dazu aufgefordert 
werden.
Schalten Sie Ihr Mobilgerät im Flugzeug aus, 
sobald Sie vom Personal der Fluggesellschaft 
dazu aufgefordert werden. Wenn Ihr Mobilgerät 
einen Flight-Modus oder eine ähnliche Funktion 
bietet, fragen Sie das Flugbegleitpersonal, ob Sie 
das Gerät während des Fluges benutzen dürfen.

Implantierbare 
Medizinprodukte
Wenn Sie ein implantierbares Medizinprodukt wie 
einen Herzschrittmacher oder Defibrillator tragen, 
wenden Sie sich an Ihren Arzt, bevor Sie dieses 
Mobilgerät nutzen.
Personen mit implantierbaren 
Medizinprodukten sollten folgende 
Vorsichtsmaßnahmen einhalten:

• Halten Sie das Mobilgerät IMMER 
mindestens 20 Zentimeter vom 
implantierbaren Medizinprodukt entfernt, 
wenn das Mobilgerät EINGESCHALTET 
ist.

• NIEMALS das Mobilgerät in einer 
Brusttasche tragen.
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• Halten Sie das Mobilgerät an das Ohr der 
dem implantierbaren Medizinprodukt 
gegenüberliegenden Körperhälfte, 
um mögliche Störungen zu minimieren.

• Schalten Sie das Mobilgerät sofort AUS, 
sollten Sie den Eindruck haben, dass 
Störungen auftreten.

Lesen und befolgen Sie die Anweisungen des 
Herstellers Ihres implantierbaren 
Medizinprodukts. Wenn Sie Fragen zur Nutzung 
Ihres Mobilgeräts mit Ihrem implantierbaren 
Medizinprodukt haben, wenden Sie sich an Ihren 
medizinischen Leistungserbringer.

Vorsichtsmaßnahmen beim 
Fahren
Erkundigen Sie sich an Ihrem jeweiligen 
Aufenthaltsort nach den dort geltenden Gesetzen 
und Bestimmungen über das Nutzen von 
Mobilgeräten in Fahrzeugen. Halten Sie sich 
immer an diese Gesetze und Bestimmungen.
Wenn Sie – soweit gesetzlich erlaubt – beim 
Fahren das Mobilgerät verwenden:

• Richten Sie Ihre ganze Aufmerksamkeit 
auf das Fahren und den Verkehr. Das 
Benutzen eines Mobilgeräts kann 
ablenken. Beenden Sie die Nutzung, 
wenn Sie sich nicht auf das Fahren 
konzentrieren können.

• Falls möglich, benutzen Sie eine 
Freisprecheinrichtung.

• Wenn die Verkehrssituation dies 
erfordert, halten Sie zum Telefonieren an, 
und parken Sie, bevor Sie das Telefon 
benutzen.

• Platzieren Sie ein Mobilgerät nicht im 
Ausbreitungsbereich des Airbags.

Ratschläge zum verantwortlichen Fahren finden 
Sie im Abschnitt „Vorsichtsmaßnahmen beim 
Autofahren“ in dieser Bedienungsanleitung und/
oder auf der Website von Motorola unter 
www.motorola.com/callsmart.
Hinweis: Die Benutzung von Mobiltelefonen kann 
beim Führen eines Fahrzeugs ablenken. Beenden 
Sie ein Gespräch, wenn Sie sich nicht auf das 
Fahren konzentrieren können. Die Nutzung von 
Mobilgeräten und deren Zubehör ist außerdem in 
bestimmten Regionen eventuell verboten oder 
nur eingeschränkt erlaubt. Die Gesetze und 
Vorschriften über die Nutzung dieser Produkte 
müssen stets eingehalten werden.

Warnhinweise
Beachten Sie alle aufgestellten Hinweisschilder für 
den Gebrauch von Mobilgeräten in öffentlichen 
Bereichen.
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Potenziell explosionsgefährdete 
Umgebungen
Potenziell explosionsgefährdete Umgebungen 
sind oft, aber nicht immer als solche 
gekennzeichnet, wie z. B. Tankstellen, 
Betankungsbereiche auf Schiffen, Umschlag- und 
Speicherplätze für Treibstoffe oder Chemikalien, 
oder Umgebungen, in denen sich Chemikalien 
oder Schwebstoffe wie Mehlstaub, Stäube oder 
Metallpulver in der Luft befinden.
Schalten Sie Ihr Mobilgerät aus, wenn Sie sich in 
einer solchen Umgebung befinden. Vermeiden Sie 
es, in solchen Umgebungen Akkus zu entfernen, 
einzubauen oder aufzuladen. Funken können in 
diesen Umgebungen zu Explosionen oder dem 
Ausbruch von Feuer führen.

Symbole
Auf Ihrem Akku, Ladegerät oder Mobilgerät finden 
Sie möglicherweise folgende Symbole:

Akkus und Ladegeräte
Vorsicht: Durch die unsachgemäße Behandlung 
oder Nutzung von Akkus kann es zu einem 
Brand, einer Explosion, zum Auslaufen des Akkus 
oder zu einer anderen Gefahrensituation 
kommen. Weitere Informationen finden Sie im 
Abschnitt „Akkuverwendung und -sicherheit“ in 
dieser Bedienungsanleitung.

Erstickungsgefahr
Ihr Mobilgerät oder das Zubehör kann 
abnehmbare Teile enthalten, die bei Verschlucken 
eine Erstickungsgefahr für Kleinkinder darstellen 
können. Halten Sie das Mobilgerät und das 
Zubehör von Kleinkindern fern.

Symbol Definition
Es folgen wichtige 
Sicherheits-informationen.

Werfen Sie Ihren Akku oder 
Ihr mobiles Gerät nicht in 
offenes Feuer.
Ihr Akku oder Mobilgerät 
sollte gemäß den geltenden 
Gesetzen recycelt werden. 
Kontaktieren Sie die 
entsprechenden Behörden 
Ihres Landes für weitere 
Informationen.

032374o

032376o

032375o

Ihr Akku oder Mobilgerät 
sollte nicht in den Hausmüll 
gelangen.
Ihr Mobilgerät enthält einen 
internen Lithium-Ionen-Akku.
Ihr Akku, Ladegerät oder 
Mobilgerät sollten nicht nass 
werden.
Das Hören von Musik oder 
das Führen von Gesprächen 
über ein Headset bei voller 
Lautstärke können das Gehör 
schädigen.

Symbol Definition

032378o
Li Ion BATT
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14 Sicherheitsinformationen

Glasbauteile
Einige Bauteile Ihres Mobilgeräts können aus Glas 
gefertigt sein. Dieses Glas kann zerbrechen, wenn 
das Produkt auf eine harte Fläche fällt oder einen 
kräftigen Stoß erhält. Berühren oder entfernen Sie 
zerbrochenes Glas nicht vom Produkt. Verwenden 
Sie Ihr Mobilgerät solange nicht, bis das Glas 
durch ein qualifiziertes Servicecenter ersetzt 
wurde.

Anfälle/Ohnmacht
Manche Personen zeigen eine erhöhte 
Bereitschaft für epileptische Anfälle oder 
Ohnmachten, wenn sie Blitzlichtern (Stroboskop-
Effekt) ausgesetzt sind, wie sie beispielsweise bei 
Videospielen auftreten. Diese Anfälle oder 
Ohnmachten können auch bei Personen auftreten, 
die niemals zuvor einen epileptischen Anfall oder 
eine Ohnmacht hatten.
Wenn Sie schon einmal einen epileptischen Anfall 
oder eine Ohnmacht hatten, oder wenn es einen 
derartigen Fall in Ihrer Familie gibt, beraten Sie 
sich mit einem Arzt, bevor Sie ein Videospiel auf 
dem Mobilgerät spielen oder einen 
stroboskopartigen Lichteffekt (sofern als Funktion 
enthalten) im Mobilgerät aktivieren.
Personen, bei denen eines der folgenden 
Symptome auftritt, sollten unverzüglich die 
Nutzung des Geräts einstellen und einen Arzt 
aufsuchen: Krämpfe, Augen- oder Muskelzucken, 
Bewusstlosigkeit, Bewegungsstörungen oder 

Desorientierung. Sie sollten das Display immer 
von Ihren Augen entfernt halten, das Licht im 
Raum anlassen, stündlich eine Pause von 
15 Minuten einlegen und die Verwendung 
einstellen, wenn Sie übermüdet sind.

Warnhinweis: Verwendung mit 
zu hoher Lautstärke

Das Hören von Musik oder das Führen 
von Gesprächen über ein Headset bei 
voller Lautstärke können das Gehör 
schädigen.

Übermäßige Belastung
Wenn Sie wiederholt die gleichen Aktionen 
ausführen, wie beispielsweise das Drücken von 
Tasten oder das Eingeben von alphanumerischen 
Zeichen, können gelegentlich Verspannungen an 
Händen, Armen, Schultern, Nacken oder anderen 
Körperteilen auftreten. Wenn Sie während oder 
nach der Verwendung anhaltende Schmerzen an 
Händen, Gelenken oder Armen verspüren, stellen 
Sie die Verwendung ein, und suchen Sie einen 
Arzt auf.
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Hinweise betreffend FCC (Federal Communications Commission)Benutzerhinweise betreffend FCC (Federal 
Communications Commission)

Die folgende Erklärung gilt für alle Produkte, für 
die eine FCC-Zulassung vorliegt. Die 
betreffenden Produkte tragen das FCC-Logo 
und/oder eine FCC-Identifikationsnummer nach 
dem Muster: xxxxxx auf dem Produkt-Etikett.
Veränderungen oder Modifizierungen an diesem 
Gerät durch den Benutzer sind nicht zulässig. Alle 
Änderungen oder Modifizierungen durch den 
Benutzer können zu einem Entzug der 
Benutzungsgenehmigung für das Gerät führen. 
Siehe Code of Federal Regulations (CFR) 47, 
Abschnitt 15.21.
Dieses Gerät entspricht Kapitel 15 der FCC-
Vorschriften. Die Inbetriebnahme unterliegt 
folgenden zwei Bedingungen: (1) Dieses Gerät 
darf keine schädlichen Interferenzen verursachen. 
(2) Das Gerät muss jegliche empfangenen 
Interferenzen aufnehmen können, einschließlich 
Interferenzen, die den ordnungsgemäßen Betrieb 
stören können. Siehe CFR 47, Abschnitt 15.19(3).
Tests mit diesem Gerät haben ergeben, dass es 
alle gültigen Beschränkungen für Digitalgeräte der 
Klasse B gemäß  Kapitel 15 der FCC-Vorschriften 
einhält. Mit diesen Beschränkungen soll ein 
angemessener Schutz gegen schädliche 
Interferenzen bei der Verwendung innerhalb von 
Wohngebieten geschaffen werden. Dieses Gerät 
erzeugt und verwendet Hochfrequenzenergie und 
kann diese abstrahlen. Bei unsachgemäßer 
Verwendung kann es schädliche Interferenzen im 

Funkverkehr verursachen. In Einzelfällen kann es 
jedoch auch bei sachgemäßer Verwendung zu 
Interferenzen kommen. Falls dieses Gerät den 
Radio- oder Fernsehempfang negativ beeinflusst 
(dies lässt sich durch Aus- und Anschalten des 
Gerätes überprüfen), sollten folgende 
Korrekturmaßnahmen ergriffen werden:

• Ändern Sie Ausrichtung oder Standort 
der Empfangsantenne.

• Vergrößern Sie den Abstand zwischen 
Gerät und Empfänger.

• Stecken Sie das Gerät an einer Steckdose 
ein, die an einem anderen Stromkreis als 
der Empfänger angeschlossen ist.

• Wenden Sie sich bei Problemen an einen 
Elektrofachhändler oder 
Fernmeldetechniker.
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XXX English
Benutzung und PflegeBenutzung und Pflege

Schützen Sie Ihr Mobiltelefon von Motorola vor:

Flüssigkeiten jeder Art
Setzen Sie das Telefon weder Wasser, Regen, extremer Luftfeuchtigkeit, Schweiß noch 
anderer Feuchtigkeit aus. Falls das Mobiltelefon nass wird, versuchen Sie nicht, das 
Trocknen mithilfe eines Ofens oder Haarföns zu beschleunigen, da hierdurch Schäden 
am Mobiltelefon entstehen können.
Extreme Hitze oder Kälte
Meiden Sie Temperaturen unter 0 °C und über 45 °C.

Mikrowellenofen
Trocknen Sie das Telefon nicht in einem Mikrowellenofen.

Staub und Schmutz
Setzen Sie das Telefon weder Staub, Schmutz, Sand, Nahrungsmittelresten noch 
anderen Reststoffen aus.

Reinigungsmittel
Reinigen Sie das Telefon mit einem trockenen weichen Tuch. Verwenden Sie weder 
Alkohol noch andere Reinigungsmittel.

Stöße
Lassen Sie das Telefon nicht fallen.
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XXX English
EU-Richtlinien KonformitätserklärungEU-Richtlinien Konformitätserklärung

Hiermit erklärt Motorola, dass dieses 
Produkt den folgenden Richtlinien 
entspricht:

• Den wesentlichen Anforderungen und 
allen anderen relevanten Bestimmungen 
der Richtlinie 1999/5/EG

• Allen anderen relevanten EU-Richtlinien

Die obige Abbildung zeigt ein Beispiel für eine 
typische Produktgenehmigungsnummer.
Sie können die der Richtlinie 1999/5/EG (die 
R&TTE-Richtlinie) zugehörige 
Konformitätserklärung (DoC) zu Ihrem Produkt 
unter der Internetadresse 
www.motorola.com/rtte abrufen. Geben Sie 
dazu die auf dem Typenschild Ihres Produkts 
angegebene Genehmigungsnummer in das auf 
der Website befindliche Feld „Suchen“ ein.

0168 Produkt-
genehmigungs-

nummer
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Informationen zum RecyclingSchutz der Umwelt durch Recycling

Produkte von Motorola, die dieses 
Zeichen tragen, dürfen nicht als 
Hausmüll entsorgt werden.

Entsorgung Ihres Mobilgeräts 
und des Zubehörs
Entsorgen Sie Mobilgeräte oder elektronisches 
Zubehör (wie Ladegeräte, Headsets oder Akkus) 
nicht mit dem Hausmüll. Entsorgen Sie diese 
Gegenstände gemäß den nationalen Sammel- und 
Recyclingprogrammen, die von Ihren örtlichen 
oder regionalen Behörden umgesetzt werden. Sie 
haben auch die Möglichkeit, nicht mehr benötigte 
Mobilgeräte und elektronisches Zubehör bei 
einem von Motorola autorisierten Servicecenter in 
Ihrer Region zurückzugeben. Einzelheiten zu von 
Motorola anerkannten nationalen 
Recyclingprogrammen und weitere Informationen 
zu Recyclingaktivitäten von Motorola finden Sie 
unter www.motorola.com/recycling.

Entsorgung der Verpackung 
und der Bedienungsanleitung 
Ihres Mobilgeräts
Entsorgen Sie die Verpackung und die 
Bedienungsanleitung des Produkts nur gemäß 
den nationalen Sammel- und 
Recyclingvorschriften. Weitere Einzelheiten 
erhalten Sie von den regionalen Behörden.
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Wichtige Informationen

Informationen zu 
diesem Handbuch
Dieses Handbuch verwendet für das Öffnen 
einer bestimmten Menüfunktion die folgende 
Schreibweise:

Zu finden unter: s > g Nachrichten > Nachricht 
erstellen

Das bedeutet, dass Sie ausgehend vom 
Standby-Display folgendermaßen vorgehen:
  1 Drücken Sie die mittlere Taste s, um das 

Hauptmenü zu öffnen.

2 Drücken Sie die Navigationstaste S, um 
zu g Nachrichten zu blättern. Drücken Sie 
dann s, um dieses Menü auszuwählen.

3 Drücken Sie die NavigationstasteS, um zu 
Nachricht erstellen zu blättern. Drücken Sie dann 
s, um dieses Menü auszuwählen.

In diesem Handbuch werden folgende Symbole 
verwendet:

Hinweis: Lesen Sie sich vor der ersten 
Inbetriebnahme Ihres Mobiltelefons 
unbedingt die wichtigen 
Sicherheitsinformationen und rechtlichen 
Hinweisen in diesem Handbuch durch.

Symbole

Dieses Symbol kennzeichnet 
Funktionen, die vom Netz, von der 
SIM-Karte bzw. Ihrem 
Mobilfunkvertrag abhängig sind und 
möglicherweise nicht überall 
angeboten werden. Weitere 
Informationen erhalten Sie von 
Ihrem Diensteanbieter.

Mit diesem Zeichen werden 
Funktionen gekennzeichnet, die 
optionales Zubehör erfordern.
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Akku

Akku aufladen
Tipp: Die Schaltkreistechnik der Motorola-Akkus 
schützen den Akku vor Schäden durch 
Überladung.

Hinweis: Verbinden Sie zum 
Aufladen des Akkus den 
Micro-USB-Anschluss des Telefons 
über das zugehörige Kabel mit dem 
USB-Anschluss eines Computers. Sowohl 
Telefon als auch Computer müssen 
eingeschaltet sein, und im Computer müssen 
die richtigen Softwaretreiber installiert sein. Ein 
MOTOROLA ORIGINAL-USB-Kabel und die 
zugehörige Software sind ggf. im Lieferumfang 
des Telefons enthalten. Dieses Zubehör ist auch 
separat erhältlich.

Achtung: Wenn Sie Ihr Mobiltelefon mit einem 
Computer mit USB-Hub verbinden, an dem 
bereits mehrere USB-Geräte angeschlossen 
sind, kann es zur Überladung des Telefonakkus 
kommen. Um eine Überladung zu vermeiden, 
sollten Sie Ihr Mobiltelefon über einen dafür 

vorgesehenen USB-Anschluss mit dem 
Computer verbinden.

Akku – Verwendung und 
Sicherheit

• Motorola empfiehlt die ausschließliche 
Verwendung von Akkus und 
Ladegeräten der Marke Motorola. Die 
Garantie für das Mobiltelefon deckt 
keine Schäden ab, die durch die 
Verwendung von Akkus und/oder 
Ladegeräten verursacht werden, die 
nicht von Motorola stammen. Hinweis: 
Die Verwendung eines nicht geeigneten 
Akkus oder Ladegeräts kann zu Feuer, 
Explosion, Undichtheit oder sonstigen 
gefährlichen Situationen führen. Die 
Verwendung eines nicht geeigneten 
oder eines beschädigten Akkus kann zu 
Feuer, Explosion oder sonstigen 
gefährlichen Situationen führen.

• Kinder dürfen den Akku nicht 
unbeaufsichtigt verwenden.

• Wichtig: Die beste Leistung für die 
Mobilgeräte von Motorola wird mit 
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geeigneten Akkus erzielt. Wenn auf dem 
Display eine Meldung wie Unzulässiger Akku 
oder Aufladen nicht möglich angezeigt wird, 
führen Sie folgende Schritte aus:

• Nehmen Sie den Akku heraus, und 
prüfen Sie, ob er das Hologramm 
„Original Equipment“ von Motorola 
trägt.

• Wenn kein Hologramm vorhanden 
ist, handelt es sich nicht um einen 
geeigneten Akku.

• Wenn ein Hologramm vorhanden 
ist, setzen Sie den Akku erneut ein, 
und starten Sie den Ladevorgang 
neu.

• Wenn die Meldung weiterhin 
angezeigt wird, wenden Sie sich an 
den Motorola-Kundendienst.

• Bei neuen Akkus oder Akkus, die über 
einen längeren Zeitraum gelagert 
wurden, ist eventuell eine längere 
Ladezeit erforderlich.

• Vorsichtsmaßnahmen beim Laden: Das 
Laden der Akkus sollte bei 
Raumtemperatur durchgeführt werden. 
Setzen Sie Akkus während des 
Ladevorgangs nie Temperaturen unter 
0 °C oder über 45 °C aus. Lassen Sie Ihr 
Mobiltelefon nicht im Fahrzeug zurück.

• Akkus sollten an einem kühlen und 
trockenen Ort gelagert werden.

• Mit der Zeit verringert sich die 
Akkulebensdauer, und der Akku weist 
kürzere Laufzeiten zwischen den 
Ladevorgängen auf oder benötigt 
häufigere oder längere Ladezeiten.

• Vermeiden Sie Schäden am Akku oder 
am Mobilgerät. Der Akku oder das 
Mobilgerät dürfen nicht zerlegt, 
geöffnet, zerdrückt, verbogen, 
deformiert, punktiert, geschreddert oder 
in Flüssigkeit getaucht werden. Der 
Akku oder das Mobilgerät dürfen nicht 
herunterfallen, insbesondere nicht auf 
eine harte Oberfläche. Wenn der Akku 
oder das Mobilgerät auf solche Weise 
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beschädigt wurden, wenden Sie sich 
vor der Verwendung an den 
Motorola-Kundendienst. Versuchen Sie 
nicht, den Akku oder das Mobilgerät 
mithilfe eines Geräts oder einer 
Wärmequelle, wie z. B. einem Haarfön 
oder einer Mikrowelle, zu trocknen.

• Gehen Sie mit einem geladenen Akku 
äußerst behutsam um – besonders, 
wenn Sie ihn in die Hosentasche, eine 
Handtasche oder in einen Behälter mit 
Metallobjekten stecken. Der Kontakt mit 
Metallobjekten (z. B. Schmuck, 
Schlüssel, Perlenketten) kann einen 
elektrischen Stromkreis bilden 
(Kurzschluss), wodurch der Akku sehr 
heiß wird. Dies kann zu Schäden oder 
Verletzungen führen.

Entsorgen Sie verbrauchte Akkus sofort 
entsprechend den örtlichen 
Bestimmungen. Hinweise zur 

ordnungsgemäßen Entsorgung des Akkus 
erhalten Sie bei Ihrer lokalen Recycling-Stelle.

Achtung: Verbrennen Sie Akkus niemals, da sie 
explodieren können.

MMSIM-Karte
Von Ihrem Telefon werden kompatible 
Multimedia-SIM (MMSIM)-Karten unterstützt.

Hinweis: Achten Sie darauf, dass die 
MMSIM-Karte nicht verbogen oder verkratzt 
wird. Schützen Sie die Karte vor statischer 
Elektrizität, Wasser und Schmutz.

Auf der MMSIM-Karte sind persönliche Daten 
(wie z. B. Ihre Telefonnummer und Kontakte) 
enthalten. Sie kann auch zum Speichern und 
Abrufen von Multimedia-Dateien wie Fotos und 
Sounds verwendet werden.

Auf der MMSIM-Karte sind möglicherweise von 
Ihrem Diensteanbieter vorkonfigurierte Daten 
gespeichert.

Hinweis: MMSIM-Karten funktionieren unter 
Umständen nicht in jedem Netzwerk. Weitere 
Informationen erhalten Sie von Ihrem 
Diensteanbieter.
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Schalten Sie vor dem Einsetzen oder 
Herausnehmen einer MMSIM-Karte das 
Mobiltelefon aus, und entfernen Sie den Akku. 
Die MMSIM-Karte wird genau wie eine 
SIM-Karte installiert und entfernt.

Auf der MMSIM-Karte 
gespeicherte Daten 
anzeigen und ändern
So können Sie die Dateien anzeigen, die auf der 
MMSIM-Karte gespeichert sind:

Zu finden unter: s > m Tools > Datei-Manager 
> MMSIM

Um eine Datei vom Mobiltelefon auf die 
MMSIM-Karte zu kopieren bzw. zu verschieben, 
markieren Sie die gewünschte Datei in der Liste, 
und drücken Sie Optionen > Verwalten 
> Kopieren oder Verschieben > MMSIM. Bestimmte mit 
einem Kopierschutz versehene Dateien können 
weder kopiert noch verschoben werden.

Zum Kopieren von Dateien zwischen der 
MMSIM-Karte und einem Computer können Sie 
eine Kabelverbindung (siehe Seite 70) oder eine 

Bluetooth™ -Verbindung (siehe Seite 72) 
verwenden. 

Hinweis: Wenn Sie das Telefon über Kabel an 
den Computer anschließen, verwenden Sie den 
Speicherkartenmodus. Die MMSIM-Karte und 
die Speicherkarte werden als separate 
Wechseldatenträger auf dem Computer 
angezeigt.

So formatieren Sie Ihre MMSIM-Karte:

Zu finden unter: s > m Tools > Datei-Manager 
> MMSIM > Optionen > MMSIM > Formatieren

So zeigen Sie den auf der MMSIM-Karte 
verfügbaren Speicherplatz sowie weitere 
Informationen zur MMSIM-Karte an:

Zu finden unter: s > u Setup > Telefon 
> Speicher anzeigen
  1 Drücken Sie S, um zur Registerkarte 

„MMSIM-Karte“ zu blättern.

2 Drücken Sie die mittlere Taste s, um die 
Informationen zur MMSIM-Karte 
anzuzeigen.
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Grundlagen

Display
Das Standby-Display wird angezeigt, wenn Sie 
das Telefon einschalten.

Hinweis: Je nach den von Ihrem 
Netzbetreiber getroffenen 
Voreinstellungen kann das Standby-Display 
Ihres Mobiltelefons von dieser Abbildung 
abweichen.

Um vom Standby-Display aus eine Rufnummer 
zu wählen, drücken Sie die Zifferntasten und 
anschließend N.

Drücken Sie die mittlere Taste s oder den 
Softkey Hauptmenü, um das Hauptmenü zu öffnen. 

Drücken Sie Schn.tast. auf dem 
Standby-Display, um das Signalprofil oder 
das Telefon-Theme zu ändern, eine Nachricht zu 
senden oder zu lesen, ein Foto oder einen 
Videoclip aufzunehmen oder ein 
Bluetooth®-Gerät zu lokalisieren.

Drücken Sie die Navigationstaste S nach 
oben, unten, links oder rechts auf dem 
Standby-Display, um auf die wichtigsten 
Menüfunktionen zuzugreifen. Informationen zum 
Anzeigen, Ausblenden oder Ändern der 
Funktionssymbole im Standby-Display finden 
Sie in der Kurzanleitung.

Tipp: Sie benötigen Hilfe? Drücken Sie Hauptmenü 
> m Tools > Hilfe. Wählen Sie ein Hilfe-Thema 

Diensteanbieter 10:10

15/10/2008
Schn.tast. Hauptmenü

Uhrzeit

Datum

Rechtes 
Softkey-
Textfeld

Linkes
Softkey-
Textfeld

Funktions-
symbole
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aus, um Informationen zu den Funktionen des 
Mobiltelefons zu erhalten.

Am oberen Rand des Standby-Displays werden 
folgende Statussymbole angezeigt:

 1 Signalstärke – Zeigt die Stärke des 
Netzsignals an.

2 EDGE/GPRS-Symbol – Zeigt an, dass 
die 
Hochgeschwindigkeitsdatenverbindung 
Enhanced Data for GSM Evolution (EDGE) 
Z oder die Verbindung General Packet 
Radio Service (GPRS) g verwendet wird.

3 Bluetooth-Symbol - Zeigt den 
Bluetooth-Status an:

4 IM-Anzeige (Instant Messaging) – 
Zeigt den aktiven IM-Status an:

5 IM-Anzeige – Dieses Symbol wird 
angezeigt, wenn Sie eine neue 
IM-Nachricht erhalten haben.

6 Nachrichtensymbol – Wird 
angezeigt, wenn Sie eine neue Text- 
oder Sprachnachricht erhalten. Beispiele für 
weitere Anzeigen:

7 Standortbestimmung – P wird 
angezeigt, wenn das Mobiltelefon 
Informationen zur Standortbestimmung an 
das Netz senden kann oder Q wird 
angezeigt, wenn die Standortbestimmung 
deaktiviert ist.

& (leuchtet blau) = Bluetooth ist aktiviert

& (leuchtet grün) = Mit Bluetooth 
verbunden

& (blinkt blau) = 
Bluetooth-Erkennungsmodus

2 1061 3 984 5 7

0 (grün) = online 2 = offline

Y = besetzt 4 = diskret

3 (grau) = für IM 
unsichtbar

 

V = 
E-Mail-Nachricht

T = 
Sprachnachricht
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8 Profilanzeige –Zeigt das eingestellte 

Signalprofil an:

9 Aktive Leitung – Zeigt B bei einem 
aktiven Anruf oder E bei einer 
Rufumleitung an.

Mögliche Symbole bei SIM-Karten mit zwei 
Rufnummern:

10 Akkuladezustand – Durch vertikale Balken 
wird der Akkuladezustand angezeigt. Bei 
Anzeige der Meldung Akku fast leer muss das 
Mobiltelefon aufgeladen werden.

Texteingabe
Bei einigen Funktionen können Sie Text 
eingeben.N = Nur 

Klingelton
K = Rufton und 
Vibration

H = Nur 
vibrieren

I = Vibrieren, dann 
klingeln

J = Kein Signal

G = Leitung 1 
aktiv

F = Leitung 2 aktiv

D = Rufumleitung 
für Leitung 1 
eingeschaltet

C = Rufumleitung 
für Leitung 2 
eingeschaltet

Texteingabemodi

Ê „Wort“-Modus (siehe Seite 27)

É „abc“-Modus (siehe Seite 28)

È Numerischer Modus (siehe Seite 29)

Ã Symbolmodus (siehe Seite 29)

ÊË

Drücken Sie #, um einen 
Texteingabemodus 

auszuwählen. Zeichenzähler

Drücken Sie Optionen, um 
die Optionen für die 

Texteingabe zu ändern.

Der blinkende Cursor 
zeigt den 

Einfügepunkt an.

Nachricht erstellen

Optionen Senden an

SMS:0
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So ändern Sie die Einstellungen für Texteingabe 
und Sprache:

Zu finden unter: s > u Setup > Telefon 
> Texteingabe

Großschreibung ändern: Drücken Sie 0, um 
zwischen den Modi „Großbuchstaben“ (Ä), 
„Wortanfang groß“ (Í) oder „Kleinbuchstaben“ 
(kein Symbol) zu wechseln.

Wortlernfunktion aktivieren: Das Telefon kann 
eingegebene neue Wörter lernen, um die 
vereinfachte Texteingabe und Wortergänzung zu 
verbessern. Drücken Sie Optionen > Texteingabe 
> Vereinfachte Texteingabe > Wörter lernen. Wenn die 
Funktion aktiviert ist, wird das Symbol Ç 
angezeigt.

Wortergänzung aktivieren: Sie können auf 
Ihrem Telefon die Wortergänzung aktivieren, die 
sich nach den von Ihnen eingegebenen 
Buchstaben richtet. Drücken Sie Optionen 
> Texteingabe > Vereinfachte Texteingabe > Wortergänzung. 
Wenn die Funktion aktiviert ist, wird das Symbol 
Æ angezeigt.

Interpunktionszeichen eingeben: Drücken Sie 
1 für die Eingabe von Satzzeichen oder 
anderen Zeichen.

Text bearbeiten oder löschen: Drücken Sie S, 
um den Cursor rechts neben den Text zu 
verschieben, den Sie bearbeiten möchten. 
Drücken Sie die Löschen-/Rücktaste D, um 
das Zeichen links vom Cursor zu löschen. Halten 
Sie D gedrückt, um den gesamten Text zu 
löschen.

Wort-Modus
Drücken Sie # in einem 
Texteingabebildschirm, um bei der Texteingabe 
zum Wort-Modus der vereinfachten Texteingabe 
zu wechseln. Auf dem Display wird Ê 
angezeigt.

Der Wort-Modus ermöglicht die vereinfachte 
Eingabe von Wörtern mit nur einem Tastendruck 
pro Buchstabe. Vom Telefon werden mögliche 
Wörter für die bisher gedrückte 
Tastenkombination vorgeschlagen.
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Wenn Sie z. B. 7 76 4 drücken, wird 
im Display möglicherweise Folgendes 
angezeigt:

abc-Modus
Drücken Sie # in einem 
Texteingabebildschirm, um zum 
„abc“-Texteingabemodus zu wechseln. Das 
Symbol É wird im Display angezeigt.

Die Texteingabe erfolgt durch wiederholtes 
Drücken einer Taste, um durch die der Taste 
entsprechenden Buchstaben, Ziffern und 
Symbole zu blättern. Wiederholen Sie diesen 
Schritt für jeden Buchstaben, den Sie eingeben 
möchten.

Wenn Sie z. B. 7 einmal drücken, wird im 
Display möglicherweise Folgendes angezeigt:

ÊÆ

Drücken Sie *, um 
Prog und ein Leerzeichen 

einzugeben.

Sie können die 
Textergänzung aktivieren 

(Æ) oder deaktivieren (Ç).

Drücken Sie S nach 
oben/unten, um weitere 

Wörter anzuzeigen.
Drücken Sie s, um ein 

Wort auszuwählen.

Drücken Sie D, um 
das Zeichen links vom 

Cursor zu löschen.

Nachricht erstellen

Optionen Senden an

SMS:4
Prog ramm

ÉÆ

Zeichenanzeige am 
Einfügepunkt.

Nachricht erstellen

Optionen Senden an

SMS:1
P rog

Nach zwei Sekunden wird das 
Zeichen übernommen, und der 
Cursor springt zum nächsten 

Einfügepunkt.
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Wenn die Wortergänzung aktiviert ist, wird das 
angefangene Wort vom Telefon vervollständigt:

• Drücken Sie s, um das 
vorgeschlagene Wort auszuwählen.

• Drücken Sie S rechts, um das 
vorgeschlagene Wort und ein 
Leerzeichen einzugeben.

• Wenn Sie ein anderes Wort wünschen, 
tippen Sie die restlichen Buchstaben 
über die Tastatur ein.

Numerischer Modus
Drücken Sie # in einem 
Texteingabebildschirm, bis È angezeigt wird. 
Geben Sie dann die gewünschten Ziffern ein.

Tipp: Sie möchten nur eine Zahl eingeben? Zum 
schnellen Eingeben einer Zahl halten Sie eine 
Zifferntaste solange gedrückt, bis die Zahl 
angezeigt wird.

Symbol-Modus
Drücken Sie # in einem 
Texteingabebildschirm, bis Ã angezeigt wird. 
Im Display wird das Symbol der jeweiligen Taste 
angezeigt. Drücken Sie wiederholt S 
oben/unten, um verschiedene Symbole 
anzuzeigen. Um ein Symbol einzufügen, drücken 
Sie die entsprechende Taste, oder blättern Sie zu 
dem Symbol, und drücken Sie s.

Lautstärke
Mithilfe der 
Lautstärketasten können 
Sie:

• Das Anrufsignal 
abschalten

• Die Lautstärke der Hörmuschel oder des 
Lautsprechers während eines Anrufs 
ändern

• Die Lautstärke während der Wiedergabe 
eines Lieds oder eines Videos ändern
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• Das Signalprofil im Standby-Display 

festlegen (Drücken Sie die 
Lautstärketasten, um zu einem Profil zu 
blättern, drücken Sie anschließend s 
oder die seitliche Auswahltaste, um 
dieses auszuwählen.)

Seitliche 
Auswahltaste
 Mit der seitlichen 
Auswahltaste können 
ebenfalls bestimmte 
Aktionen durchgeführt 
werden. Wenn Sie z. B. zu 
einem Menüelement blättern, können Sie dieses 
mithilfe der seitlichen Auswahltaste (anstelle 
von s) auswählen.

Externes Display
Bei geschlossener Telefonklappe zeigt das 
externe Display die Uhrzeit und den 
Telefonstatus, eingehende Anrufe und andere 
Ereignisse an.

Signaltyp auf dem externen 
Display auswählen
Drücken Sie die externen Lautstärketasten 
seitlich am Telefon, um zu einem Profil zu 
blättern. Drücken Sie anschließend die seitliche 
Auswahltaste, um das Profil auszuwählen.

Sensortasten des externen 
Displays verwenden
Beim Abspielen von Musik auf Ihrem 
Mobiltelefon können Sie die Telefonklappe 
schließen und die Wiedergabe der Musiktitel 
über die Sensortasten des externen Displays 
steuern. (Weitere Informationen hierzu finden 
Sie in der Kurzanleitung.)

Hinweis: Die Sensortasten des externen 
Displays werden nur zur Steuerung des 
Musik-Players verwendet.

Sprachsteuerung
Mit Sprachbefehlen können Sie dem Telefon 
Anweisungen erteilen.
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Hinweis: Sprachbefehle werden nicht für alle 
Sprachen unterstützt.

Sprachwahl
Sie können einen Eintrag in Ihrer Kontaktliste 
anrufen, indem Sie den Namen des Eintrags 
oder die einzelnen Ziffern einer Rufnummer 
sprechen.
  1 Drücken Sie die externe Sprachbefehltaste 

seitlich am Telefon. Das Telefon lädt die 
Spracherkennungssoftware und fordert Sie 
dann auf, einen Befehl oder Namen zu 
sprechen.

2 Warten Sie auf den Signalton, bevor Sie 
den Namen eines Eintrags aus der 
Kontaktliste sprechen. Der Name wird 
bestätigt und die Verbindung anschließend 
hergestellt.

oder

Sagen Sie „Nummer wählen“. Sie werden 
aufgefordert, die Ziffern der Rufnummer zu 
sprechen. Sprechen Sie die Ziffern. Die 
Nummer wird bestätigt und die Verbindung 
anschließend hergestellt.

Tipps:

• Sie können den Namen des Kontakts 
und den Nummerntyp zusammen 
sprechen. Sagen Sie z. B. „Johannes 
Schmidt Mobil“, um die für Johannes 
Schmidt gespeicherte 
Mobiltelefonnummer anzurufen.

• Um die Sprachbefehlhilfe aufzurufen, 
drücken Sie die Sprachbefehltaste 
seitlich am Telefon und anschließend 
Hilfe.

Telefonfunktionen per 
Sprachbefehl aktivieren
Mit Sprachbefehlen können Sie Anwendungen 
öffnen und viele grundlegende 
Telefonfunktionen ausführen.
  1 Drücken Sie die externe Sprachbefehltaste 

seitlich am Telefon. Sie werden 
aufgefordert, einen Befehl zu sprechen.
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2 Warten Sie auf den Signalton, bevor Sie 

einen Sprachbefehl aus der Liste sprechen.

Tipp: Drücken Sie kurz die Sprachbefehltaste 
seitlich am Telefon, um die Liste der 
Sprachbefehle anzuzeigen.

Sprachmodus
Sie können Ihr Telefon so einstellen, dass 
Informationen zum Anrufer angesagt, 
Menüfunktionen oder Einträge in der 
Kontaktliste sowie eingehende Nachrichten 
vorgelesen und Informationen zu 
Telefonfunktionen akustisch wiedergegeben 
werden.

Zu finden unter: s > u Setup > Telefon 
> Sprachmodus

Schnellzugriff: Halten Sie die externe 
Sprachbefehltaste seitlich am Telefon gedrückt. 
Wenn Sie vom Telefon aufgefordert werden, 
einen Befehl zu sprechen, sagen Sie 
„Sprachmodus“. 

Sprachbefehle
„Name“ 
„Rufnummer wählen“ 
„Nachricht senden an Name“ 
„Kalender prüfen“ 
„Nachrichteneingang prüfen“ 
„E-Mail-Eingang prüfen“ 
„Neuen Kontakt hinzufügen“ 
„Sprachmodus“ 
„Akku überprüfen 
„Signal überprüfen“ 
„Uhrzeit anzeigen“ 
„Datum anzeigen“ 
„Telefon-Setup öffnen“ 
„Anrufliste öffnen“ 
„Themes öffnen“ 
„Kamera öffnen“ 
„Browser-Menü öffnen“ 
„Flugzeugmodus einschalten“ 
„Flugzeugmodus abschalten“ 
„Klingelton einstellen“ 
„Normal einstellen“ 

„Vibration einstellen“ 
„Stumm einstellen“ 

Sprachbefehle
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Freisprechfunktion
Zum Einschalten der Freisprechfunktion 
während eines Gesprächs drücken Sie Optionen 
> Lautsprecher ein. Auf dem Display wird das 
Lautsprechersymbol angezeigt, bis Sie die 
Funktion deaktivieren (drücken Sie dazu Optionen 
> Lautsprecher aus) oder den Anruf beenden.

Hinweis: Durch das Benutzen von 
Mobiltelefonen beim Autofahren ist die 
Konzentration eingeschränkt. Es ist daher 
untersagt, während des Fahrens zu telefonieren. 
Außerdem ist die Verwendung von drahtlosen 
Geräten und deren Zubehör in bestimmten 
Umgebungen unter Umständen verboten. Die 
Gesetze und Vorschriften zur Nutzung dieser 
Produkte müssen stets eingehalten werden.

Codes und 
Passwörter
Der vierstellige Entsperrcode Ihres Telefons ist 
werkseitig auf 1234 eingestellt. Der sechsstellige 
Sicherheitscode ist werkseitig auf 000000 

eingestellt. Sofern der Diensteanbieter diese 
Codes nicht geändert hat, sollten Sie dies tun:

Zu finden unter: s > u Setup > Sicherheit 
> Passwörter ändern

Sie können außerdem Ihre SIM-PIN-Codes oder 
das Kennwort für die Anrufsperre ändern.

Falls Sie Ihren Entsperrcode vergessen: Geben 
Sie bei der Aufforderung Bitte Entsperrcode eingeben: 
1234 oder die letzten vier Ziffern Ihrer 
Telefonnummer ein. Wenn das nicht funktioniert, 
drücken Sie #, und geben Sie stattdessen den 
sechsstelligen Sicherheitscode ein.

Falls Sie einen anderen Code vergessen 
sollten: Wenn Sie den Sicherheitscode, den PIN- 
oder PIN2-Code der SIM-Karte oder das 
Passwort für die Anrufsperre vergessen haben, 
wenden Sie sich an Ihren Diensteanbieter.

Seitentasten sperren 
und freigeben
Sie können bei geschlossener Telefonklappe die 
externen Tasten des Telefons sperren, um ein 
versehentliches Drücken der Tasten (z. B. beim 
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Abspielen von Musik oder Tragen des Telefons 
in der Hand- oder Hosentasche) zu vermeiden.

So sperren Sie die externen Tasten 
automatisch, wenn das Telefon im 
Standby-Modus und die Telefonklappe 
geschlossen ist:

Zu finden unter: s > u Setup > Sicherheit 
> Externe Tastensperre > Timer:

Sie können die Zeitverzögerung für das Sperren 
der externen Tasten einstellen (4 Sekunden, 
6 Sekunden oder 12 seconds). Die Tasten werden 
gesperrt, sobald Sie die Telefonklappe 
schließen. Wenn Sie die Telefonklappe öffnen, 
werden die Tasten entsperrt.

So deaktivieren Sie die automatische 
Sperrfunktion:

Zu finden unter: s > u Setup > Sicherheit 
> Externe Tastensperre > Timer: > Aus

So entsperren Sie die externen Tasten bei 
geschlossener Telefonklappe: Halten Sie die 
seitliche Auswahltaste gedrückt.

Mobiltelefon 
sperren/entsperren
Sie können das Mobiltelefon sperren, damit es 
niemand außer Ihnen benutzen kann. Zum 
Sperren oder Entsperren Ihres Telefons 
benötigen Sie den vierstelligen Entsperrcode.

Manuelle Sperre des Mobiltelefons:

Zu finden unter: s > u Setup > Sicherheit 
> Telefonsperre > Jetzt sperren

Automatisches Sperren des Mobiltelefons bei 
jedem Ausschalten:

Zu finden unter: s > u Setup > Sicherheit 
> Telefonsperre > Einschaltsperre > Ein
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Persönliche Einstellungen

Profile
Sie können das Signalprofil des Telefons schnell 
an Ihre Aktivitäten oder Umgebung anpassen. 
Jedem Profil sind unterschiedliche Signaltöne 
oder Vibrationsalarme für eingehende Anrufe 
und andere Ereignisse zugeordnet. Das 
Signalprofil-Symbol wird oben auf dem 
Standby-Display angezeigt (Informationen zu 
den Symbolen finden Sie auf Seite 26).

So ändern Sie Ihr Profil: Drücken Sie im 
Standby-Display die externen Lautstärketasten 
seitlich am Telefon. Sie können im 
Standby-Display auch Schn.tast. > Signaltyp ändern 
oder Profil ändern drücken.

Das Profil Stumm stellt Ihr Mobiltelefon solange 
stumm, bis Sie ein anderes Profil einstellen.

Schnellzugriff: Halten Sie im Standby-Display 
# gedrückt, um das Profil schnell in Vibrieren zu 
ändern.

Signalprofil-Einstellungen 
ändern
Sie können die Signaltöne ändern, die für 
eingehende Anrufe und andere Ereignisse 
verwendet werden. Sie können außerdem die 
Signallautstärke, die Tastenlautstärke und die 
Lautstärke für die Wiedergabe der 
Multimediadateien ändern. Bei SIM-Karten mit 
zwei Rufnummern können Sie verschiedene 
Klingeltöne einstellen, um eingehende Anrufe 
auf Leitung 1 oder Leitung 2 zu unterscheiden.

Hinweis: Der Klingelton für den Signaltyp Stumm 
und einige Einstellungen für bestimmte 
Signaltypen können nicht geändert werden.

N Klingelton K Klingelton & Vibr.

H Vibrieren I Vibr. dann Klingelton

J Stumm  
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Zu finden unter: s > u Setup > Profile 
> Signaltyp > Signaltyp
  1 Drücken Sie S links/rechts, um die 

Registerkarte Signale [, Lautstärke i, 
Nachrichten ] oder Einstellungen # 
auszuwählen.

2 Drücken Sie S oben/unten, um zur 
Signal- oder Lautstärkeeinstellung zu 
blättern, die Sie ändern möchten. Drücken 
Sie dann s.

3 Wählen Sie die gewünschte Einstellung.

4 Drücken Sie Zurück, um die Änderungen zu 
speichern und das Menü zu beenden.

So führen Sie das Zurücksetzen der 
Standardeinstellungen für einen Signaltyp aus:

Zu finden unter: s > u Setup > Profile 
> Signaltyp > Signaltyp, drücken Sie Optionen 
> Zurücksetzen.

Neues Profil erstellen
So erstellen Sie ein neues Profil mit den 
gewünschten Signaltönen und 
Lautstärkeeinstellungen:

Zu finden unter: s > u Setup > Profile 
> Signaltyp > Signaltyp
  1 Geben Sie einen Namen ein und ändern die 

Einstellungen wie im vorherigen Abschnitt 
beschrieben.

2 Drücken Sie Optionen > Als Profil spei.

3 Geben Sie einen Namen für das Profil ein, 
und drücken Sie Speichern, um es zu 
speichern.

So erstellen Sie zusätzliche Profile:

Zu finden unter: s > u Setup > Profile, 
drücken Sie Optionen > Profil erstellen.

Hinweis: Einstellungen für ein Signalprofil 
können auch durch ein Theme bestimmt 
werden. Wenn Sie ein neues Theme anwenden, 
können Sie auswählen, die Signaleinstellungen 
des Themes auf das aktuelle Profil anzuwenden. 
Durch Auswahl dieser Option wird das aktuelle 
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Profil geändert. Nun werden die 
Signaleinstellungen des Themes verwendet.

Profile bearbeiten oder 
löschen
So bearbeiten Sie ein Profil:

Zu finden unter: s > u Setup > Profile, blättern 
Sie zum Profil, drücken Sie Optionen > Bearbeiten.

Hinweis: Das Profil Stumm kann nicht geändert 
werden.

So löschen Sie ein benutzerdefiniertes Profil:

Zu finden unter: s > u Setup > Profile, blättern 
Sie zum Profil, drücken Sie Optionen > Löschen.

Standardeinstellungen 
wiederherstellen
So löschen Sie alle benutzerdefinierten Profile 
und stellen die ursprünglichen 
Profil-Einstellungen Ihres Telefons wieder her:

Zu finden unter: s > u Setup > Profile, 
drücken Sie Optionen > Toneinstell. zurücks.

Zeit und Datum
Das Telefon kann die Uhrzeit und das Datum 
automatisch aktualisieren. Die Zeit sowie das 
Datum werden für den Kalender verwendet.

So synchronisieren Sie Datum und 
Uhrzeit mit dem Netz:

Zu finden unter: s > u Setup > Telefon 
> Uhrzeit & Datum > Uhrzeit Auto-Update > Ein

So stellen Sie Datum und Uhrzeit manuell ein:

Zu finden unter: s > u Setup > Telefon 
> Uhrzeit & Datum > Uhrzeit Auto-Update > Aus, 
anschließend > Zeit und Datum

Zum Einstellen der Uhrzeit und des Datums 
drücken Sie S links/rechts, um zu einer 
Einstellung zu blättern. Drücken Sie 
anschließend S oben/unten, um die 
Einstellung zu ändern. Drücken Sie Auswählen, um 
die Einstellungen zu speichern.
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So zeigen Sie im Standby-Display die digitale 
Uhrzeit im 12-Stunden- oder 
24-Stunden-Format an:

Zu finden unter: s > u Setup > Telefon 
> Uhrzeit & Datum > Uhrzeitformat > 12-Stunden-Format 
oder 24-Stunden-Format

So legen Sie das Datumsformat im 
Standby-Display fest:

Zu finden unter: s > u Setup > Telefon 
> Uhrzeit & Datum > Datumsformat

So legen Sie die Zeitzone fest:

Zu finden unter: s > u Setup > Telefon 
> Uhrzeit & Datum > Zeitzone, wählen Sie 
anschließend einen Ort in Ihrer Zeitzone.

Schnellzugriff: Geben Sie über die 
Buchstabentasten die ersten Buchstaben des 
gesuchten Orts ein.

Themes
Mit einem Telefon-Theme können Sie das 
Aussehen und den Sound Ihres Telefons 
personalisieren. In der Regel umfassen Themes 
ein Wallpaper, einen Screensaver und einen 
Signalton.

So aktivieren Sie ein Theme:

Zu finden unter: s > u Setup > Themes 
> Theme

Informationen zum Herunterladen von Themes 
finden Sie auf Seite 51.

So löschen Sie ein Theme:

Zu finden unter: s > u Setup > Themes, 
blättern Sie zum Theme, und drücken Sie Optionen 
> Verwalten > Löschen.

Hinweis: Sie können nur heruntergeladene 
Themes oder benutzerdefinierte Themes, die Sie 
erstellt haben, löschen.
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Ein Foto als Wallpaper 
verwenden
So können Sie ein Foto als Wallpaper 
(Hintergrundbild) Ihres Standby-Displays 
verwenden:

Zu finden unter: s > u Setup > Themes, 
drücken Sie Optionen > Bearbeiten.
  1 Drücken Sie S nach rechts, um die 

Registerkarte Bilder auszuwählen $.

2 Drücken Sie S nach unten, um zu Wallpaper 
zu blättern, und drücken Sie dann s, um 
dieses auszuwählen.

3 Blättern Sie zum gewünschten Foto, und 
drücken Sie Auswählen.

Hinweis: Wenn das Foto auf der 
eingesetzten Speicherkarte abgelegt wurde, 
wählen Sie Zurück zu Bilder > Zurück zu 
Meine Dateien > Speicherkarte > Meine Fotos, um 
nach Fotos auf der Speicherkarte zu 
suchen.

4 Drücken Sie Speichern, um Ihre Auswahl zu 
speichern.

Zu finden unter: Fotos, die von einem anderen 
Gerät auf das Mobiltelefon übertragen wurden, 
haben möglicherweise nicht die für ein 
Wallpaper erforderliche Größe. So passen Sie 
die Größe eines Wallpapers  an die Größe des 
Displays an: s > u Setup > Themes, drücken 
Sie Optionen > Bearbeiten
  1 Drücken Sie Snach rechts, um die 

Registerkarte Bilder auszuwählen $.

2 Drücken Sie S nach unten, um zu 
Wallpaper-Layout zu blättern, und drücken Sie 
dann s, um es auszuwählen.

3 Blättern Sie zu Anpassen, und drücken Sie 
Auswählen.

4 Drücken Sie Speichern, um die Einstellung zu 
speichern.

Theme ändern
Zu finden unter: s > u Setup > Themes, 
blättern Sie zum Theme, drücken Sie Optionen 
> Bearbeiten.
  1 Drücken Sie S links/rechts, um die 

Registerkarte Sounds [ oder Bilder $ 
auszuwählen.
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2 Drücken Sie S oben/unten, um zur 

Einstellung zu blättern, die Sie ändern 
möchten. Drücken Sie dann s.

3 Blättern Sie zur gewünschten Bild- oder 
Sounddatei, und wählen Sie diese aus.

4 Drücken Sie Speichern, um die Änderungen 
am Theme zu speichern und das Menü zu 
beenden.

Das Wallpaper wird als Hintergrundbild auf dem 
Standby-Display angezeigt.

Der Screensaver wird aktiviert, wenn über einen 
festgelegten Zeitraum keine Aktivität festgestellt 
wurde.

Mit Skins ändern Sie das Erscheinungsbild des 
Telefondisplays.

So führen Sie das Zurücksetzen auf 
Standardeinstellungen für ein geändertes 
Theme aus:

Zu finden unter: s > u Setup > Themes 
> Theme, drücken Sie Optionen > Verwalten 
> Zurücksetzen.

So stellen Sie das Standard-Theme für das 
Telefon wieder her:

Zu finden unter: s > u Setup > Themes, 
drücken Sie Optionen > Verwalten 
> Auf Standardeinstellungen zurücksetzen.

Neues Theme erstellen
Zu finden unter: s > u Setup > Themes, 
drücken Sie Optionen > Theme erstellen oder 
Kopie erstellen.

Displayeinstellungen
So stellen Sie die Helligkeit des internen 
Displays ein:

Zu finden unter: s > u Setup > Telefon 
> Display > Helligkeit

Zum Einsparen der Akkuleistung kann das 
Display Ihres Telefons ausgeschaltet werden, 
wenn Sie es nicht verwenden. So legen Sie das 
Verzögerungsintervall für das Deaktivieren des 
Displays fest:

Zu finden unter: s > u Setup > Telefon 
> Display > Timeout Display
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So aktivieren bzw. deaktivieren Sie den 
Screensaver des internen Displays:

Zu finden unter: s > u Setup > Telefon 
> Display > Screensaver > Ein oder Aus

Tipp: Zur Verlängerung der Akkulaufzeit 
empfiehlt es sich, den Screensaver zu 
deaktivieren.

Rufannahme
Sie können einen eingehenden Anruf auf 
verschiedene Arten annehmen. So aktivieren 
bzw. deaktivieren Sie eine Annahmeoption:

Zu finden unter: s > u Setup > Anrufe 
> Gesprächsoptionen > Rufannahme

Hinweis: Sie können immer N drücken, um 
einen Anruf anzunehmen.

Optionen

Tasten drücken Annahme durch Drücken 
einer beliebigen Taste.

Klappe öffnen Annahme durch Öffnen der 
Telefonklappe.
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Anrufe

Abschalten des 
Anrufsignals
Drücken Sie die externen Lautstärketasten 
seitlich am Telefon, um den Klingelton 
abzuschalten, bevor Sie einen Anruf 
entgegennehmen.

Anrufliste
Das Mobiltelefon verwaltet Listen der ein- und 
ausgehenden Anrufe, auch wenn bei diesen 
Anrufen kein Gespräch zustande kam. Die Liste 
beginnt mit den neuesten Anrufen. Die jeweils 
ältesten Anrufe werden gelöscht, wenn neue 
Anrufe hinzukommen.

Schnellzugriff: Drücken Sie im Standby-Display 
N, um die Liste Gewählte Anrufe anzuzeigen.

Zu finden unter: s > q Anrufliste

  1 Wählen Sie mit S links/rechts eine 
Anrufliste aus: Alle Anrufe, Gewählte Anrufe, 
Beantwortete Anrufe, Entgangene Anrufe oder 
Häufige Anrufe.

2 Blättern Sie mit S oben/unten zu einer 
Telefonnummer.

Anhand der Symbole erkennen Sie, ob ein Anruf 
eingegangen ist -, abgegangen ist + oder 
verpasst wurde =. Durch ein Häkchen neben 
dem Symbol wird angezeigt, dass Sie mit der 
Nummer verbunden sind.

• Drücken Sie zum Wählen der Nummer 
N.

• Zum Anzeigen von Detailinformationen 
(z. B. Datum und Uhrzeit) zu einem Anruf 
drücken Sie s.

• Drücken Sie Optionen, wenn Sie weitere 
Optionen für diese Nummer nutzen 
möchten (z. B. Nachricht senden, in der 
Kontaktliste speichern) oder Optionen 
für die zuletzt eingegangenen Anrufe 
einstellen möchten.
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Wahlwiederholung
  1 Drücken Sie im Standby-Display N, um 

die Liste Gewählte Anrufe anzuzeigen.

2 Blättern Sie zu der Nummer, die Sie anrufen 
möchten, und drücken Sie N.

Wenn Sie ein Besetztzeichen hören und 
die Meldung Anruf gescheitert angezeigt wird, 
drücken Sie N oder Erneut versuchen, um die 
Rufnummer erneut zu wählen. Beim 
Durchstellen des Anrufs wird die Meldung 
Verbunden angezeigt.

Zurückrufen
 Nicht angenommene Anrufe werden vom 
Mobiltelefon erfasst und die Meldung X 
Entgangene Anrufe angezeigt. Dabei steht X für die 
Anzahl der verpassten Anrufe.

Wenn die Nachricht X Entgangene Anrufe angezeigt 
wird, drücken Sie s, um die Liste 
Entgangene Anrufe aufzurufen. Blättern Sie zu dem 
Eintrag, den Sie zurückrufen möchten, und 
drücken Sie N.

Anrufer-ID
Mit der Anrufer-Identifizierung 
(Anrufer-ID) wird die Rufnummer eines 
eingehenden Anrufs auf dem Display des 
Telefons angezeigt.

Auf dem Telefon werden Name und Bild des 
Anrufers angezeigt, wenn diese in der 
Kontaktliste gespeichert sind. Falls keine 
Anruferinformationen verfügbar sind, wird auf 
dem Display Eingehender Anruf... angezeigt.

Hinweis: Bild-IDs sind für auf der SIM-Karte 
gespeicherte Kontakte nicht verfügbar.

Tipp: Möchten Sie den Anrufer schon am 
Klingelton erkennen? Informationen zum 
Zuweisen eines speziellen Klingeltons für einen 
Kontakt finden Sie auf Seite 83.

Um Ihre Rufnummer beim nächsten 
abgehenden Anruf anzuzeigen bzw. zu 
unterdrücken, geben Sie die Rufnummer ein, die 
Sie wählen möchten, und drücken dann Optionen 
> ID anzeigen oder ID verbergen.
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So übermitteln oder unterdrücken Sie Ihre 
Rufnummer für alle Anrufe:

Zu finden unter: s > u Setup > Anrufe 
> Gesprächsoptionen > Meine Anrufer-ID > Alle Anrufe 
> ID übermitteln oder ID verbergen

Notrufe
Ihr Diensteanbieter hat mindestens eine 
Notrufnummer (beispielsweise 112) 
programmiert, die Sie jederzeit anrufen können, 
auch wenn das Telefon gesperrt oder keine 
SIM-Karte eingelegt ist.

Hinweis: Überprüfen Sie dies bei Ihrem 
Diensteanbieter, da die Notrufnummern 
länderabhängig sind. Das Telefon funktioniert u. 
U. nicht überall. Aufgrund von Netzproblemen, 
Umwelteinflüssen oder Interferenzen sind 
Notrufe manchmal nicht möglich. Verlassen Sie 
sich bei dringenden Anrufen (z. B. bei 
medizinischen Notfällen) nicht ausschließlich auf 
Ihr Mobiltelefon.

So tätigen Sie einen Notruf: Schalten Sie das 
Telefon ein, schließen Sie alle offenen 
Anwendungen wie z. B. Spiele, und geben Sie 
die Notrufnummer ein. Drücken Sie 
anschließend die Sendetaste N, um die 
Notrufnummer anzurufen.

Sprachnachrichten
Empfangene Sprachnachrichten werden 
in Ihrer Mailbox gespeichert. Zum 
Abhören der Nachrichten rufen Sie Ihre 
Mailbox an.

Hinweis: Von Ihrem Diensteanbieter erhalten 
Sie ggf. weitere Informationen zur Nutzung 
dieser Funktion.

Wenn Sie eine Sprachnachricht erhalten, 
werden auf dem Display die Nachricht 
Neue Sprachnachricht und das 
Sprachnachrichtensymbol U angezeigt.

Abhören der Sprachnachrichten:

Zu finden unter: s > g Nachrichten 
> Mailbox anrufen
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Schnellzugriff: Ihr Diensteanbieter hat 
möglicherweise die Rufnummer Ihrer Mailbox 
bereits der Kurzwahltaste #1 zugeordnet. Halten 
Sie in diesem Fall die Taste 1 auf dem 
Standby-Display gedrückt, um die Nachrichten 
in Ihrer Mailbox abzurufen.
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Unterhaltung

Musik-Player
Grundlegende Hinweise zum Musik-Player 
finden Sie in der Kurzeinführung.

Hinweis: Das unbefugte Kopieren von 
urheberrechtlich geschütztem Material verstößt 
gegen die Bestimmungen des 
Urheberrechtsgesetzes der USA und anderer 
Länder. Dieses Gerät darf nur zum Kopieren von 
folgendem Material verwendet werden: nicht 
urheberrechtlich geschütztes Material, Material, 
für das Sie Urheberrechte besitzen oder 
Material, für das Sie über eine Befugnis oder 
gesetzliche Berechtigung zum Kopieren 
verfügen. Wenn Sie nicht sicher sind, welche 
Rechte Sie im Hinblick auf das Kopieren von 
Material haben, holen Sie sich juristischen 
Rat ein.

So legen Sie das 
Standardformat für 
Audiodateien und die Bitrate 
fest:
Mit dem Media Player 11 von Microsoft® 
Windows® können Sie Dateiformat und Bitrate 
so einstellen, dass die Klangqualität optimiert 
wird. Außerdem kann die Anzahl der Lieder 
erhöht werden, die Sie auf dem Telefon 
speichern können.

Das Windows Media Audio-Format ermöglicht 
das optimale Gleichgewicht zwischen 
Dateigröße und Tonqualität. Songdateien in 
diesem Format benötigen mehr Speicherplatz 
als Dateien im Windows Media Audio 
Pro-Format.
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Das Windows Media Audio Pro-Format wurde 
für die Verwendung in tragbaren Geräten mit 
begrenzter Speicherkapazität konzipiert. Das 
Format bietet eine verbesserte Tonqualität zu 
geringeren Bitraten.

So legen Sie das Standarddateiformat und die 
Bitrate fest:
  1 Legen Sie die Musik-CD in das CD-Laufwerk 

des Computers ein.

2 Starten Sie Windows Media Player 11.

3 Wählen Sie in Windows Media Player 11 die 
Registerkarte „Von Medium kopieren“.

4 Klicken Sie auf der Registerkarte „Von 
Medium kopieren“ auf den Pfeil nach unten, 
und wählen Sie Format > Windows Media 
Audio oder Windows Media Audio Pro.

5 Klicken Sie erneut auf der Registerkarte 
„Von Medium kopieren“ auf den Pfeil nach 
unten, und wählen Sie Bitrate > Bitrate.

iTunes AAC-Dateien in 
MP3-Dateien auf dem 
Computer umwandeln:
Verwenden Sie die iTunes-Desktopanwendung, 
um iTunes-AAC-Standarddateien in 
MP3-Dateien umzuwandeln, die mit Windows 
Media Player 11 kompatibel sind.

Hinweis: Mit der iTunes-Desktopanwendung 
können Sie nur AAC-Dateien umwandeln, die 
von einer Musik-CD gerippt wurden. Sie können 
mit dieser Anwendung keine Musikdateien 
umwandeln, die Sie über den iTunes Store 
erworben haben.
  1 Starten Sie die iTunes-Desktopanwendung 

auf dem Computer.

2 Wählen Sie Bearbeiten > Einstellungen, 
und klicken Sie anschließend auf die 
Registerkarte „Erweitert“. Klicken Sie dann 
auf „Importieren“.

3 Öffnen Sie das Popup-Menü „Importieren 
mit“, und wählen Sie die Option 
„MP3-Codierer“. Klicken Sie auf OK, um die 
Einstellungen zu speichern.
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4 Wählen Sie mindestens ein Lied in der 

iTunes-Musikbibliothek. Wählen Sie 
anschließend Erweitert > Auswahl in MP3 
konvertieren.

Die umgewandelten MP3-Dateikopien werden in 
der Musikbibliothek des Computers zusammen 
mit den AAC-Originaldateien angezeigt.

Musik manuell auf das 
Telefon oder die 
Speicherkarte übertragen
Ohne Windows Media Player 11 können Sie 
Musiktitel manuell vom Computer in den 
Telefonspeicher oder auf eine optionale 
MicroSD-Speicherkarte im Telefon übertragen. 
(Informationen zum Einsetzen der Speicherkarte 
finden Sie in der Kurzeinführung).

Überprüfen Sie vor dem Kopieren von Dateien 
auf das Telefon, ob das Dateiformat vom Telefon 
erkannt wird: Mit dem Musik-Player können 
folgende Dateiformate wiedergegeben werden: 
AMR-NB, AMR-WB, AAC (MPEG4 AAC-LC), 
AAC+, Enhanced AAC+, MP3, 8-Bit-Linear PCM, 
16-Bit-Linear PCM, 8-Bit-A-Law PCM, 

8-Bit-mu-Law PCM, WMA v9 L2 (auch WMA v3, 
v7, v8), Real Audio LBR (COOK), Real Audio 
Sipro (ACELP®.net), Real Audio 10.

Telefon:
Drücken Sie s > u Setup > Verbindungen 
> USB-Einstellung > Speicherkarte

Verbinden Sie den 
Micro-USB-Anschluss des Telefons 
über das Motorola 
Original-USB-Kabel mit einem freien 
USB-Anschluss an Ihrem Computer. Ein 
Motorola Original-USB-Kabel und die 
zugehörige Software sind ggf. im Lieferumfang 
des Telefons enthalten. Dieses Zubehör ist auch 
separat erhältlich.

Computer:
Das Telefon und die Speicherkarte werden als 
Wechseldatenträger auf dem Computer 
angezeigt.
  1 Ermitteln Sie, wo das Telefon und die 

Speicherkarte als 
Wechseldatenträgersymbole angezeigt 
werden. Auf einem Windows-Computer 
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finden Sie diese Symbole im Fenster 
„Arbeitsplatz“. Auf einem 
Macintosh®-Computer befinden sich diese 
Symbole auf dem Desktop.

2 Doppelklicken Sie auf das 
Wechseldatenträgersymbol für das Telefon 
oder die Speicherkarte.

3 Um die gewünschten Dateien auf das 
Telefon oder die Speicherkarte zu kopieren, 
ziehen Sie diese mit Drag-and-Drop auf das 
entsprechende Wechseldatenträgersymbol.

4 Trennen Sie anschließend das Telefon 
ordnungsgemäß vom Computer.

• Klicken Sie auf einem 
Windows-Computer mit der rechten 
Maustaste auf das Symbol „Hardware 
sicher entfernen“ in der Taskleiste unten 
auf dem Bildschirm. Wählen Sie den 
Eintrag „USB-Massenspeicher 
entfernen“.

• Ziehen Sie auf einem  Mac-Computer 
das Wechseldatenträgersymbol auf den 
Papierkorb.

Musik abspielen
Hinweis: Informationen zur Musikwiedergabe 
bei geschlossener Telefonklappe finden Sie in 
der Kurzeinführung.

Mit der Navigationstaste S können Sie die 
Musikwiedergabe bei geöffneter Telefonklappe 
steuern.

01:15 02:40

Drücken Sie S zum Abspielen 
bzw. Anhalten (Pause) nach oben 

und zum Stoppen nach unten. 
Drücken Sie S links/rechts, um 

zum vorherigen bzw. nächsten 
Titel zu springen.

Anzeige der 
bereits 

abgespielten 
Zeit

Musik-Player-Optionen 
auswählen und 

anpassen.

Zurück zum 
vorherigen 
Bildschirm.

Titel

Optionen Zurück

Musiktitel
Künstler
Album

Album
Cover

10/10/2008--910 KB
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Drücken Sie während der Musikwiedergabe 
Optionen, um auf die Musik-Player-Optionen 
zuzugreifen:

Optionen

Ausblenden Musik-Player während der 
Wiedergabe ausblenden. Um 
den Musik-Player wieder 
einzublenden, drücken Sie im 
Standby-Display S nach 
oben.

Verwalten Eigenschaften des Musiktitels, wie 
z. B. Dateiname, Typ und Größe, 
anzeigen.

Entfernen Musikdatei löschen.

Senden an Musiktitel in einer Textnachricht 
oder E-Mail verschicken oder 
über eine 
Bluetooth®-Verbindung an ein 
anderes Gerät senden.

Verwenden als Musiktitel zu einer Playliste 
hinzufügen oder zu einem 
Klingelton konvertieren.

Bluetooth 
verwenden/ 
Mobiltelefon 
verwenden

Um Musik an ein 
Bluetooth-Headset zu 
übertragen, aktivieren Sie die 
Bluetooth-Funktion. Wählen Sie 
dann Bluetooth verwenden, um eine 
Verbindung zu einem erkannten 
Bluetooth-Headset herzustellen 
oder nach einem neuen 
Headset zu suchen.

Wählen Sie bei aktivierter 
Bluetooth-Audioverbindung 
Mobiltelefon verwenden, um die 
Bluetooth-Verbindung zu 
trennen und den Ton wieder auf 
das Telefon umzuleiten.

Hinweis: Diese Option wird nur 
dann angezeigt, wenn 
Bluetooth aktiviert ist.

Einrichten Einstellungen anpassen.

Optionen
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Während der Musikwiedergabe zeigt der 
Musik-Player gegebenenfalls Musiktitel, 
Interpret, Album und Cover an. Um ein größeres 
Bild des Covers anzuzeigen, drücken Sie s 
(drücken Sie s erneut, um zum Musik-Player 
zurückzukehren).

Musik-Player anpassen
Zu finden unter: [, drücken Sie Optionen 
> Einrichten.

Sie können folgende Optionen auswählen:

Wenn Sie zu einem Song in einer Liste blättern 
und Optionen drücken, werden möglicherweise 
zusätzliche Optionen für den Song und die Liste 
angezeigt, wie z. B. Löschen, Senden an und 
Verwenden als.

Browser
Verwenden Sie den HTML-Browser des 
Telefons, um Ihre Websites aufzurufen, Videos 
auf ein Videoblog zu laden und Dateien und 
Anwendungen auf das Telefon herunterzuladen. 
Melden Sie sich bei Ihrem Internet-E-Mail-Konto 
an, um Ihre E-Mail unterwegs abzurufen.

So starten Sie den Browser:

Zu finden unter: s > 1 Web-Zugriff > Browser

Optionen

Zufällige 
Wiedergab.

Musiktitel in einer zufälligen 
Reihenfolge wiedergeben.

Auto. 
Wiederholung

Den Musiktitel oder die 
Playliste erneut 
wiedergeben, sobald die 
Wiedergabe der letzten Datei 
beendet ist.

Stereoeffekte Aktivieren Sie Raumklang und 
Bass Boost, um den Ton 
anzupassen.

Internetverbindung Legen Sie Ihre 
Internet-Verbindungs-
einstellungen fest.

Optionen
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Drücken Sie S oben, unten, links oder rechts, 
um durch die Webseiten zu blättern. Blättern Sie 
zu einem Link, und drücken Sie s, um ihn 
auszuwählen. Sie können jederzeit auf Zurück 
drücken, um zum vorherigen Bildschirm 
zurückzukehren.

Einige Webseiten können ein Texteingabefenster 
für den Austausch von Informationen mit einer 
Website enthalten. Blättern Sie zu einem Fenster, 
wählen Sie es aus, und geben Sie den Text wie 
gewohnt ein (weitere Informationen zur 
Texteingabe finden Sie auf Seite 26).

Um eine Webseite aufzurufen, drücken Sie 
Optionen > URL aufrufen, geben die Internetadresse 
ein und drücken anschießend Start.

Um ein Lesezeichen für die aktuelle Webseite zu 
setzen, drücken Sie Optionen > Aktive Seite 
> Bookmark hinzufügen.

Um eine Webseite mit einem Lesezeichen 
aufzurufen, drücken Sie Optionen > Bookmarks 
> Lesezeichen.

Informationen zum Hochladen von Videoclips 
auf eine Blogsite finden Sie auf Seite 58.

Zum Herunterladen einer Multimediadatei, eines 
Themes oder einer Java™-Anwendung auf das 
Telefon, öffnen Sie die Seite, die mit der Datei 
verknüpft ist, blättern Sie zu dem Link, und 
wählen Sie diesen aus.

Zum Beenden des Browsers, drücken Sie Optionen 
> Beenden.

Browser-Einstellungen
Für die Verwendung des Browsers Ihres 
Mobiltelefons muss dieser entsprechend für den 
Internetzugang konfiguriert werden. Zudem 
muss dieser Datendienst für Ihr Konto durch 
Ihren Diensteanbieter aktiviert werden. (Für 
diesen Dienst können zusätzliche Gebühren 
anfallen.)

Falls erforderlich, erhalten Sie die nötigen 
Informationen zur Einstellung des 
Internetbrowsers für Ihr Mobiltelefon direkt von 
Ihrem Diensteanbieter, oder besuchen Sie die 
folgende Website:

https://hellomoto.wdsglobal.com/site/phonefirst
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Hinweis: Über die Website stehen 
möglicherweise nicht alle Einstellungen des 
Diensteanbieters zur Verfügung.

Kamera
Mit der 2-Megapixel-Digitalkamera des Telefons 
können Sie Fotos in einer Auflösung von bis zu 
1200 x 1600 Pixel aufnehmen. Richten Sie Ihr 
Mobiltelefon auf das Motiv, und nehmen Sie ein 
Foto auf. Drücken Sie anschließend Senden, um 
das Foto an Ihre Freunde zu senden.

Foto aufnehmen
Zu finden unter: s > j Multimedia > Kamera

Schnellzugriff: Drücken Sie im Standby-Display 
die seitliche Auswahltaste, um die Kamera zu 
aktivieren. Das interne Display des Mobiltelefons 
dient als Kamerasucher.

Schnellzugriff: Drücken Sie im Standby-Display 
die seitliche Auswahltaste, um die Kamera zu 
aktivieren.

Drücken Sie s, um das Bild mit dem 
Kamerasucher einzufangen.

• Um das Foto zu speichern, drücken 
Sie s.

370

Optionen Zurück

Kameramodus
(Foto oder Video)

Speicher (Mobiltelefon 
oder Speicherkarte)

Timer

Drücken Sie S nach oben 
oder unten, um die 

Kameraeinstellungen 
anzuzeigen, und nach 

rechts oder links, um die 
Einstellungen zu ändern.

Kameraoptionen 
auswählen und 

anpassen.

Zurück zum 
vorherigen 
Bildschirm.

Verblei-
bende 
Aufnahmen

Auflösung

Zoom
x1
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• Drücken Sie Senden, um das Foto in 

einer Nachricht zu versenden 
(siehe Seite 62).

• Drücken Sie D, um das Foto zu 
löschen.

• Um weitere Fotooptionen auszuwählen, 
drücken Sie Optionen. Sie können 
folgende Optionen auswählen: 
Nur speichern, Löschen, Senden an (Nachricht, 
E-Mail oder Bluetooth-Verbindung), 
Verwenden als (Wallpaper, Screensaver, 
neuer oder vorhandener Kontakt), 
Bearbeiten oder Drucken über 
(Bluetooth-Verbindung, USB-Verbindung 
oder Speicherkarte).

Foto anzeigen
So zeigen Sie ein aufgenommenes Foto an:

Zu finden unter: s > j Multimedia > Media Finder 
> Bilder > Aufgenommene Bilder > Foto

Automatisches Senden
Sie können das Telefon so einrichten, dass die 
aufgenommenen Fotos an eine Liste von 
angegebenen Kontakten gesendet werden.

Um Fotos automatisch versenden zu können, 
müssen Sie zunächst die automatische 
Speicherfunktion aktivieren.

Zu finden unter: s > j Multimedia > Kamera, 
drücken Sie Optionen > Kameraeinstellungen 
> Autom. Speichern > Aktivieren.

Legen Sie anschließend den Speicherort für 
automatisch gespeicherte Fotos fest:

Zu finden unter: s > j Multimedia > Kamera, 
drücken Sie Optionen > Kameraeinstellungen 
> Speicherort > Telefon oder Speicherkarte

Aktivieren Sie dann das automatische Senden:

Zu finden unter: s > j Multimedia > Kamera, 
drücken Sie Optionen > Kameraeinstellungen 
> Autom. Senden > Aktivieren.
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So legen Sie die Empfänger für die 
aufgenommenen Fotos fest:

Zu finden unter: s > j Multimedia > Kamera, 
drücken Sie Optionen > Kameraeinstellungen 
> Nachrichtenempfänger.

Tipp: Um das Foto in einer MMS-Textnachricht 
zu senden, müssen Sie für die Bildauflösung die 
Optionen Extraklein, Klein oder Mittel einstellen. Zum 
Einstellen der Auflösung drücken Sie 
s > j Multimedia > Kamera. Drücken Sie dann 
Optionen > Kameraeinstellungen > Bildeinstellungen 
> Auflösung.

Kameraeinstellungen
Wenn der Kamerasucher aktiviert ist, können Sie 
die Navigationstaste S verwenden, um die 
folgenden Kameraeinstellungen vorzunehmen. 
Drücken Sie S nach unten oder oben, um zu 
einer Einstellung zu blättern. Drücken Sie 
anschließend S nach rechts oder links, um die 
Einstellung zu ändern:

Einstellungen

Zoom Um den Bildausschnitt durch 
Zoomen zu vergrößern oder 
zu verkleinern, drücken Sie 
S nach rechts bzw. nach 
links.

Style Drücken Sie S nach links 
oder rechts, um Farbe, 
Schwarzweiß, Antik, Negativ, Rötlich, 
Grünlich oder Bläulich 
auszuwählen.

Szenerie Drücken Sie S nach links 
oder rechts, um Automatisch, 
Nacht oder Manuell auszuwählen.

Belichtung (Stellen Sie Szenerie zum 
Anpassen auf Manuell ein.) 
Drücken Sie S nach links 
oder nach rechts, um die 
Belichtungszeit zu erhöhen 
bzw. zu reduzieren.
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Drücken Sie bei aktiviertem Kamerasucher 
Optionen, um die Kameraoptionen auszuwählen:

Lichtverhältnisse (Stellen Sie Szenerie zum 
Anpassen auf Manuell ein.) 
Drücken Sie S nach links 
oder rechts, um zu den 
Optionen Automatisch, Sonnig, 
Bewölkt, Innen (Zuhause) oder 
Innen (Büro) zu gelangen.

Kennung Wählen Sie eine 
Beschriftungsvorlage aus, 
die Sie Ihren Fotos zuordnen 
möchten. (Um eine Vorlage 
zu erstellen, drücken Sie 
Optionen > Kameraeinstellungen 
> Kennung 
> Neue Kennung erstellen).

Optionen

Aufnahme Foto aufnehmen

Gehe zu My Media Gespeicherte Bilder und 
Fotos anzeigen, bearbeiten 
und löschen

Einstellungen

Videomodus Zur Videokamera umschalten

Selbstauslöser Aktivieren des 
Selbstauslösers

Serienbild Aktivieren der Aufnahme 
von Serienfotos

Kameraeinstellungen Kameraeinstellungen 
personalisieren: 
  •  Überprüfungszeit
  •  Kennung
  •  Standardname
  •  Speicherort
  •  Autom. Speichern
  •  Autom. Senden
  •  Nachrichtenempfänger
  •  Bildeinstellungen
        •  Auflösung
        •  Verschlussgeräusch
        •  Qualität
  •  Videoeinstellungen
        •  Auflösung
        •  Aufnahmeton
        •  Qualität
        •  Videolänge

Optionen
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Videos

Videos aufnehmen
Zu finden unter: s > j Multimedia > Videokamera

  1 Drücken Sie s, um die Videoaufnahme zu 
starten.

2 Drücken Sie Stopp, um die Videoaufnahme 
zu beenden.

• Um den Videoclip zu speichern, drücken 
Sie s.

• Um den Videoclip in einer 
Nachricht zu versenden, drücken 
Sie Senden.

• Drücken Sie D, um das Video zu 
löschen.

• Um weitere Videooptionen 
auszuwählen, drücken Sie Optionen. Sie 
können den Videoclip Nur speichern, Löschen, 
Senden an (Nachricht, E-Mail oder 
Bluetooth-Verbindung) oder als Vorschau 
anzeigen.

Tipp: Um den Videoclip in einer 
MMS-Textnachricht versenden zu können, 
müssen Sie für dessen Länge entweder Kurz (MMS) 
oder Lang (MMS) einstellen. Zum Einstellen der 
Länge drücken Sie s > j Multimedia > Kamera, 
und drücken Sie anschließend Optionen 
> Kameraeinstellungen > Videoeinstellungen > Videolänge.

1:48:00

Optionen Zurück

Kameramodus
(Foto oder Video)

Speicher (Mobiltelefon 
oder Speicherkarte)

Audio
(Ein oder

Aus)

Drücken Sie S nach 
oben oder unten, um die 

Einstellungen der 
Videokamera anzuzeigen, 

und nach rechts oder 
links, um die 

Einstellungen zu ändern.

Videokameraoptionen 
auswählen und 

anpassen.

Zurück 
zum 
vorherigen 
Bildschirm.

Verbleibende 
Minuten

Auflösung

Zoom
x1
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Drücken Sie bei aktiviertem Kamerasucher auf 
Optionen, um die Optionen für die Videoaufnahme 
auszuwählen:

Videoclip auf eine Blogsite 
hochladen
So laden Sie Videoclips auf Ihre Video-Blogsite 
hoch:
  1 Öffnen Sie den Browser des Telefons 

(drücken Sie dazu s > 1 Web-Zugriff 
> Browser).

2 Öffnen Sie eine Videoblog-Website.

3 Melden Sie sich an.

4 Blättern Sie zu Upload Videos, und drücken 
Sie s.

5 Sie werden vom Browser dazu 
aufgefordert, den Videoclip auszuwählen, 
den Sie hochladen möchten. Drücken Sie 
anschließend s.

6 Blättern Sie zu Upload läuft..., und drücken 
Sie s.

Der Videoclip wird auf die Blogsite hochgeladen.

Videos abspielen
Zu finden unter: s > j Multimedia > Media Finder 
> Videos > Video 

Optionen

Aufnahme Videoaufnahme starten.

Gehe zu My Media Gespeicherte Videos 
anzeigen, bearbeiten und 
löschen.

Bildmodus Zur Fotokamera 
umschalten.

Audio Ein/Aus Audioaufnahme 
aktivieren/deaktivieren.

Kameraeinstellungen Kameraeinstellungen 
anpassen (siehe Seite 55).
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Drücken Sie während der Videowiedergabe 
Optionen, um auf die Video-Optionen zuzugreifen:

Hinweis: Die Optionen Ihres Telefons können 
sich von den folgenden Optionen 
unterscheiden. Die meisten Optionen beziehen 

sich nur auf vom Benutzer aufgenommene 
Videos und stehen nicht für vorinstallierte 
Videos zur Verfügung.

00:06 00:12

Drücken Sie S, um die 
Wiedergabe eines 

Videoclips anzuhalten/zu 
starten, zu stoppen oder 
zum vorherigen/nächsten 

Videoclip zu springen.

Der Timer 
zeigt die 
bereits ab-
gespielte 
Zeit in 
Prozent an.

Musik-Player-Optionen 
auswählen und 

anpassen.

Zurück zum 
vorherigen 
Bildschirm.

Videotitel

Optionen Zurück

15/10/2008-78 KB

Drücken Sie s, um 
den Videoclip in 

seiner tatsächlichen 
Größe bzw. im 
Vollbildmodus 

anzuzeigen. Optionen

In Vollans. 
abspielen

Video auf dem gesamten 
Bildschirm anzeigen. (Drücken 
Sie s, um zur tatsächlichen 
Größe zurückzukehren.)

Verwalten Eigenschaften eines Videos 
anzeigen, wie z. B. Dateiname, 
Format und Größe.

Löschen Video löschen.

Zoom Video in der tatsächlichen 
Größe anzeigen oder Videobild 
auf den gesamten Bildschirm 
vergrößern.

Senden an Video in einer Nachricht, E-Mail 
oder über eine 
Bluetooth-Verbindung an ein 
anderes Gerät senden.
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Bluetooth 
verwenden/ 
Mobiltelefon 
verwenden

Um Musik an ein 
Bluetooth-Headset zu 
übertragen, aktivieren Sie die 
Bluetooth-Funktion. Wählen 
Sie dann Bluetooth verwenden, um 
eine Verbindung zu einem 
erkannten Bluetooth-Headset 
herzustellen oder nach einem 
neuen Headset zu suchen.

Wählen Sie bei aktivierter 
Bluetooth-Audioverbindung 
Mobiltelefon verwenden, um die 
Bluetooth-Verbindung zu 
trennen und den Ton wieder 
auf das Telefon umzuleiten.

Hinweis: Diese Option wird nur 
dann angezeigt, wenn 
Bluetooth aktiviert ist.

Einrichten Videoeinstellungen anpassen.

Optionen
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Unterstützte Videoformate
Bevor Sie Dateien auf das Mobiltelefon 
kopieren, prüfen Sie, ob das Dateiformat vom 
Telefon erkannt wird. Folgende Formate werden 
unterstützt: MPEG4 + AMR-NB, MPEG4 + 
AMR-WB, MPEG4 + AAC/AAC+/Enhanced 
AAC+, H.263 + AMR-NB, H.263 + AMR-WB, 
H.263 + AAC/AAC+/Enhanced AAC+, Real 
Audio + Video, H.264 + AMR-NB, H.264 + 
AMR-WB, H264 + AAC/AAC+/Enhanced AAC+, 
WMV 9 + WMA v9 L2, sowie WMA v3, v7, v8.
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Nachrichten

Textnachrichten

Nachricht senden
Eine Nachricht kann Text, Bilder, Musik 
oder andere Multimediadateien enthalten. 
Sie können mehrseitige Nachrichten verfassen 
und auf jede Seite Text und Multimediadateien 
einfügen. Die fertige Nachricht kann an 
kompatible Telefone oder E-Mail-Adressen 
gesendet werden.
 Zu finden unter: s > g Nachrichten > Nachricht 
erstellen
 1 Geben Sie über das Tastenfeld Text auf eine 

Seite ein. (Informationen zur Texteingabe 
finden Sie auf Seite 26).

Um ein Bild-, Ton- oder andere Mediadatei 
einzufügen, drücken Sie Optionen > Einfügen. 
Wählen Sie den Dateityp und die Datei. 
(Hinweis: Möglicherweise gelten für Bilder 

und Videoclips, die Sie in einer Nachricht 
senden, Dateigrößenbeschränkungen.)

Um eine neue Seite hinzuzufügen, drücken 
Sie Optionen > Einfügen > Seite. Auf der neuen 
Seite können Sie weiteren Text und weitere 
Objekte hinzufügen.

2 Drücken Sie nach Fertigstellen der 
Nachricht Optionen > Sendeoptionen, um die 
Nachrichtenoptionen einzustellen 
(beispielsweise Betreff und Priorität).

3 Nachdem Sie die gewünschten 
Nachrichtenoptionen festgelegt haben, 
drücken Sie Fertig.

4 Drücken Sie Senden an, um die Empfänger der 
Nachricht auszuwählen. Sie haben folgende 
Möglichkeiten:

• Einen oder mehrere Einträge aus der 
Kontaktliste wählen (drücken Sie S, 
um zu einem Eintrag zu blättern, und 
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anschließend s, um diesen 
auszuwählen).

• Neue Nummer oder E-Mail-Adresse 
eingeben (drücken Sie Optionen 
> Rufnummer eingeben oder E-Mail eingeben).

5 Drücken Sie Senden zum Senden der 
Nachricht.

Möglicherweise erhalten Sie die Meldung, 
dass es sich um eine Multimedia- bzw. 
MMS-Nachricht handelt, wenn mehrere 
Seiten oder Mediadateien vorhanden sind. 
Nicht alle Telefone oder Netze unterstützen 
MMS-Nachrichten. Drücken Sie Ja zum 
Senden der Nachricht.

Um die Nachricht zu speichern oder 
abzubrechen, drücken Sie Optionen 
> In Entwürfe speichern oder Nachricht abbrechen.

Nachricht empfangen
Wenn Sie eine Nachricht erhalten, ertönt 
ein Signalton, und auf dem internen 
Display wird Neue Nachricht zusammen mit dem 
Nachrichtensymbol U angezeigt.

Um die Nachricht zu lesen, drücken Sie Anzeigen. 
Falls die Nachricht Multimediadateien enthält:

• Beim Lesen der Nachricht werden Bilder 
und Animationen angezeigt.

• Beim Lesen der Nachricht werden 
Sounddateien wiedergegeben. Drücken 
Sie die externen Lautstärketasten 
seitlich am Telefon, um die Lautstärke zu 
ändern.

• Angehängte Dateien befinden sich am 
Ende der Nachricht. Um einen Anhang 
zu öffnen, wählen Sie das Dateisymbol 
oder den Dateinamen aus.

Um die Nachricht zu beantworten, drücken Sie 
Optionen > Antworten.
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Erweiterte Nachrichten- und 
E-Mail-Funktionen

Funktionen

Textvorlage senden

s > g Nachrichten > Vorlagen 
> Textvorlagen > Vorlage, drücken Sie Optionen 
> Senden.

So erstellen Sie eine neue Textvorlage:

s > g Nachrichten > Vorlagen > Textvorlagen, 
drücken Sie Optionen > Vorlage erstellen.

E-Mail-Konten einrichten

Mehrere E-Mail-Konten im Telefon 
einrichten und verwenden:

s > g Nachrichten > E-Mail > Konto hinzufügen

Hinweis: Das Display zeigt einen separaten 
Ordner für jedes E-Mail-Konto an.

E-Mail senden

s > g Nachrichten > E-Mail

MMS-Vorlage verwenden

MMS-Vorlage mit vorinstallierten 
Mediadateien, z. B. Bild, öffnen:

s > g Nachrichten > Vorlagen > MMS-Vorlagen

Neue Nachricht oder E-Mail lesen

Wenn die Meldung Neue Nachricht 
angezeigt wird, drücken Sie Read.

Nachrichten lesen

s > g Nachrichten > Eingang

Symbole neben den einzelnen Nachrichten 
kennzeichnen deren Status: gelesen >, 
ungelesen ], dringend < oder mit 
Anhang *. Die Taste Optionen bietet weitere 
Möglichkeiten zur Bearbeitung von E-Mails.

E-Mails lesen

s > g Nachrichten > E-Mail

Die Taste Optionen bietet weitere Möglichkeiten 
zur Bearbeitung von E-Mails.

Funktionen
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Instant Messaging
Mit Instant Messaging können Sie 
Nachrichten in Echtzeit mit Ihren 
Freunden austauschen.

Zu finden unter: s > m Tools > IM, blättern 
Sie zu Ihrem IM-Konto. Drücken Sie dann 
Anmelden.

Wenn Sie nicht über ein IM-Konto verfügen, 
wählen Sie [Neues Konto], um ein Konto zu 
erstellen.

Nachrichtenobjekte speichern

Öffnen Sie eine Seite mit 
Multimedia-Inhalt, und drücken Sie Optionen 
> Speichern.

Ordner erstellen

Erstellen Sie einen persönlichen Ordner 
für das Speichern Ihrer Nachrichten.

s > g Nachrichten > Meine Ordner, drücken Sie 
Optionen > Ordner erstellen.

Browser-Nachrichten

Mit dem Browser empfangene 
Nachrichten lesen:

Wenn die Meldung Neue Nachricht angezeigt 
wird, drücken Sie Anzeigen.

So aktivieren Sie Browser-Nachrichten und 
passen die Einstellungen für 
Browser-Nachrichten an:

s > g Nachrichten, drücken Sie Optionen 
> Einstellungen > Browser-Nachrichten.

Funktionen

Cell Broadcast

Abonnierte Cell Broadcast-Nachrichten 
anzeigen:

Wenn die Meldung Neue Nachricht angezeigt 
wird, drücken Sie Anzeigen.

So aktivieren Sie Cell Broadcast und passen 
die Einstellungen hierfür an:

s > g Nachrichten, drücken Sie Optionen 
> Einstellungen > Cell Broadcast.

Funktionen
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Um andere Benutzer online zu finden, wählen 
Sie Kontaktliste, um eine Liste mit anderen 
Benutzern anzuzeigen.

Um ein Gespräch zu starten, blättern Sie in der 
Liste Online-IM-Kontakte zu einem Namen und 
drücken IM send.

Um ein aktives Gespräch zu öffnen, blättern Sie 
in der Liste Gespräche zu einem Namen und 
drücken Anzeigen.

Um ein Gespräch zu beenden, drücken Sie 
Optionen > Gespräch beenden.

Um sich bei der Instant Messaging-Sitzung 
abzumelden, drücken Sie Optionen > Abmelden.

IM-Accounts erstellen oder 
bearbeiten
So erstellen Sie ein neues IM-Konto:

Zu finden unter: s > m Tools > IM 
> [Neues Konto]

So bearbeiten Sie ein vorhandenes IM-Konto:

Zu finden unter: s > m Tools > IM, blättern 
Sie zu einem Konto. Drücken Sie dann Optionen 
> Konto bearbeiten.
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Verbindungen

MOTOSYNC
Zum Synchronisieren von Informationen 
zwischen Ihrem Telefon und einem 
Remote-Server stehen Ihnen verschiedene 
Funkverbindungsmethoden zur Verfügung.

MOTOSYNC mit Exchange 
ActiveSync
Über das Internet können Sie die 
Kontaktliste, Kalendereinträge und E-Mails 
auf Ihrem Telefon mit einem E-Mail-Konto auf 
einem Microsoft® Exchange 2003 Server 
synchronisieren.

Exchange ActiveSync einrichten
Stellen Sie sicher, dass die Mobility-Option für 
das E-Mail-Konto und der Datendienst bei Ihrem 
Diensteanbieter aktiviert ist (für diesen Dienst 
können zusätzliche Gebühren anfallen).

So richten Sie einen ActiveSync-Partner ein:

Zu finden unter: s > m Tools > MOTOSYNC 
> Exchange ActiveSync

Geben Sie die Informationen für Ihr 
E-Mail-Konto und den Server ein, einschließlich 
Benutzername, Passwort, Domäne, Serveradresse:* und 
Datenverbindung. Wenden Sie sich gegebenenfalls 
an Ihren IT-Systemadministrator, um die 
erforderlichen Informationen oder Hilfe zum 
Verbinden des Telefons mit dem Server zu 
erhalten.

Exchange ActiveSync verwenden
Legen Sie fest, wann die Daten auf Ihrem 
Telefon automatisch mit einem Exchange 
ActiveSync-Partner synchronisiert werden 
sollen:

Zu finden unter: s > m Tools > MOTOSYNC 
> Exchange ActiveSync, drücken Sie Optionen 
> Autom. Synchronisier. > Ein und OK, um die Uhrzeit 
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und Wochentage für die Synchronisierung 
einzugeben.

So synchronisieren Sie Kontakte, 
Kalendereinträge und E-Mails manuell:

Zu finden unter: s > m Tools > MOTOSYNC 
> Exchange ActiveSync > Jetzt synchronisier.

Die erste Synchronisierung kann einige Minuten 
dauern. Dies hängt von der Datenmenge in der 
Kontaktliste, im Kalender und in den E-Mails auf 
dem Exchange 2003-Server ab.

MOTOSYNC mit SyncML
Sie können einen SyncML-Internet-Server 
anrufen und die Kontaktliste und 
Kalendereinträge mit dem Server 
synchronisieren.

So synchronisieren Sie Dateien mit einem von 
Ihnen eingerichteten Partner:

Zu finden unter: s > m Tools > MOTOSYNC 
> SyncML

Wenn kein SyncML-Profil auf dem Telefon 
gespeichert ist, werden Sie aufgefordert, ein 
Profil zu erstellen. Wenden Sie sich an Ihren 

IT-Systemadministrator, um die erforderlichen 
Informationen für das Einrichten eines Profils zu 
erhalten.

Hinweis: Wenn das Telefon keine Verbindung 
zum Server herstellen kann, vergewissern Sie 
sich, ob der Diensteanbieter Ihres Telefonnetzes 
den Datendienst für Ihr Telefon aktiviert hat 
(möglicherweise fällt für diesen Service eine 
zusätzliche Gebühr an).

Datei-Manager
Verwalten Sie Musik- und Audiodateien, Fotos, 
Videoclips und andere auf Ihrem Telefon oder 
auf einer optionalen externen 
MicroSD-Speicherkarte vorhandenen Dateien.

Zu finden unter: s > m Tools > Datei-Manager

Wählen Sie einen Ordner oder die Speicherkarte 
aus, um den Inhalt anzuzeigen.

Um eine Audiodatei oder eine Sprachnachricht 
wiederzugeben oder ein Foto oder einen 
Videoclip anzuzeigen, blättern Sie zur 
gewünschten Datei, und wählen Sie diese aus.
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So bearbeiten Sie eine Datei: Blättern Sie zu der 
Datei, und drücken Sie Optionen > Verwalten um 
diese zu kopieren, zu verschieben oder 
umzubenennen. Außerdem stehen Ihnen 
Optionen zum Löschen, Verschicken oder 
Anwenden der Datei zur Verfügung. Einige 
Funktionen können nicht bei bestimmten 
urheberrechtlich geschützten oder 
vorinstallierten Dateien ausgeführt werden.

Zum Kopieren von Dateien zwischen dem 
Telefon und einem Computer können Sie eine 
Kabelverbindung (siehe nächsten Abschnitt) 
oder eine Bluetooth®-Verbindung (siehe 
Seite 73) verwenden.

Speicherkarte formatieren
So formatieren Sie die Speicherkarte oder 
zeigen die Eigenschaften der Speicherkarte (z. 
B. Name und verfügbarer Speicherplatz) an:
 Zu finden unter: s > m Tools > Datei-Manager
 1 Drücken Sie S, um zur Speicherkarte zu 

blättern.

2 Drücken Sie Optionen > Speicherkarte 
> Formatieren oder Eigenschaften.

Dateien zwischen Telefon 
und Speicherkarte 
verschieben oder kopieren
Hinweis: Wenn Sie eine Datei an einen neuen 
Speicherort verschieben, wird die Datei am 
ursprünglichen Speicherort gelöscht.

Zu finden unter: s > m Tools > Datei-Manager
  1 Blättern Sie zu der Datei, die Sie 

verschieben oder kopieren möchten.

2 Drücken Sie Optionen > Verwalten > Verschieben 
oder Kopieren.

Hinweis: Die Optionen Verschieben und Kopieren 
werden nicht angezeigt, wenn die Datei 
urheberrechtlich geschützt ist.

3 Blättern Sie zum Zielspeicherort, und 
drücken Sie Platzieren.
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Kabelverbindungen 
Um Daten 
zwischen 

dem Telefon und 
einem Computer zu 
übertragen, 
schließen Sie den 
Micro-USB-Stecker 
eines USB-Kabels an den Micro-USB-Anschluss 
des Telefons an. Schließen Sie das andere Ende 
des Kabels an den Computer an.

Hinweis: Ein Motorola 
Original-USB-Kabel und die 
zugehörige Software sind ggf. im 
Lieferumfang des Telefons 
enthalten. Dieses Zubehör ist auch separat 
erhältlich. Überprüfen Sie Ihren Computer auf 
den erforderlichen Kabeltyp.

Hinweis: Einige Telefonfunktionen sind 
vorübergehend nicht verfügbar, wenn eine 
USB-Verbindung aktiv ist.

So übertragen und synchronisieren Sie 
Musikdateien von Ihrem Computer auf eine im 
Telefon eingesetzte Speicherkarte mit Hilfe des 

Windows Media Players 11: Drücken Sie 
s > K Verbindungen > USB-Einstellung 
> Mediadatei-Sync, und verbinden Sie Ihr 
Mobiltelefon anschließend mit dem Computer. 
Weitere Informationen dazu finden Sie in der 
Kurzanleitung.

So übertragen Sie Musikdateien, Bilder und 
Videos manuell zwischen Computer und 
Mobiltelefon (Telefonspeicher oder eingesetzte 
Speicherkarte): Drücken Sie s > K 
Verbindungen > USB-Einstellung > Speicherkarte, und 
verbinden Sie Ihr Mobiltelefon anschließend mit 
dem Computer. Weitere Informationen zur 
manuellen Übertragung von Musikdateien 
finden Sie auf Seite 48.

So verwenden Sie das Telefon als Modem: 
Verwenden Sie die 
Modemverbindungseinstellungen auf dem 
Telefon (drücken Sie s > u Setup 
> Verbindungen > USB-Einstellung > Modem). Verbinden 
Sie Telefon und Computer.

So übertragen Sie Kontaktlisten und 
Kalendereinträge zwischen Telefon und 
Computer: Führen Sie die als Zubehör 
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erhältliche Anwendung „Motorola Phone Tools“ 
auf Ihrem Computer aus. Über die „Phone 
Tools“-Software wird automatisch die zum 
Synchronisieren notwendige 
Verbindungseinstellung für Ihr Telefon 
festgelegt. Weitere Informationen finden Sie in 
der Bedienungsanleitung der „Phone Tools“.

So führen Sie Datenanrufe über einen Computer 
aus: Verwenden Sie die 
Modemverbindungseinstellungen auf dem 
Telefon (drücken Sie s > u Setup 
> Verbindungen > USB-Einstellung > Modem). Verbinden 
Sie Telefon und Computer. Sie können den 
Anruf über die Computeranwendung tätigen 
oder annehmen.

Um eine neue Datenverbindung auf dem 
Telefon herzustellen, drücken Sie s > u Setup 
> Verbindungen > Datenverbindungen > Neue Verbindung.

So drucken Sie ein Bild über eine 
USB-PictBridge-Verbindung: Verwenden Sie die 
Druckerverbindungseinstellung auf dem Telefon 
(drücken Sie  s > u Setup > Verbindungen 
> USB-Einstellung > USB-Druck). Schließen Sie das 
Telefon an einen mit PictBridge kompatiblen 

Drucker an. Wählen Sie die zu druckenden Bilder 
aus, und drücken Sie Optionen > Drucken über > USB.

USB-Verbindung trennen 
Hinweis: Trennen Sie die Verbindung zwischen 
Mobiltelefon und Computer nicht während der 
Übertragung von Dateien.

Auf einem PC mit Windows XP™ oder höher: 
Wenn die Datenübertragung abgeschlossen ist, 
ziehen Sie das USB-Kabel von Mobiltelefon und 
Computer ab.

Auf einem PC mit früheren 
Windows-Betriebssystemen: Klicken Sie in der 
Taskleiste unten am Bildschirm des Computers 
auf das Symbol „Hardware sicher entfernen“, 
und wählen Sie anschließend 
„USB-Massenspeichergerät“. Ziehen Sie das 
USB-Kabel vom Mobiltelefon und Computer ab.

Auf einem Macintosh®-Computer: Ziehen Sie 
das Symbol „Wechseldatenträger“ in den 
Papierkorb. Ziehen Sie das USB-Kabel von 
Mobiltelefon und Computer ab.
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Bluetooth®- 
Verbindungen
Ihr Mobiltelefon unterstützt Bluetooth. Sie 
können Ihr Telefon mit einem optionalen 
Bluetooth-Headset, einem 
Bluetooth-Autoeinbausatz zum Freisprechen 
oder mit Bluetooth-Stereokopfhörern verbinden, 
um auf dem Telefon gespeicherte Musik zu 
hören. Verbinden Sie das Telefon zum 
Dateiaustausch mit einem Gerät, das 
Bluetooth-Verbindungen unterstützt. Zum 
Drucken von Bildern verbinden Sie das Telefon 
mit einem Drucker, der mit Bluetooth kompatibel 
ist. Außerdem können Sie das Telefon als 
Bluetooth-Modem verwenden, um auf das 
Internet zuzugreifen.

Um die Bluetooth-Funktion mit einem 
Höchstmaß an Sicherheit zu nutzen, sollten die 
Bluetooth-Geräte immer in einer sicheren, 
privaten Umgebung gekoppelt werden.

Bluetooth-Funktion des 
Mobiltelefons aktivieren 
oder deaktivieren
Die Bluetooth-Funktion des Telefons wird 
automatisch aktiviert, wenn eine 
Bluetooth-Funktion verwendet wird.

So aktivieren oder deaktivieren Sie die 
Bluetooth-Funktion:

Zu finden unter: s > u Setup > Verbindungen 
> Bluetooth, drücken Sie Optionen > Bluetooth-Setup 
> Bluetooth-Power > Ein

Hinweis: Um die Akkubetriebszeit zu erhöhen 
und die Bluetooth-Sicherheit zu maximieren, 
stellen Sie die Bluetooth-Funktion immer auf Aus, 
wenn Sie diese nicht verwenden. Ihr 
Mobiltelefon wird solange keine Verbindung mit 
einem anderen Gerät herstellen, bis Sie erneut 
eine Bluetooth-Funktion verwenden oder 
Bluetooth wieder auf Ein stellen.
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Bluetooth-Headset oder 
-Autoeinbausatz zum 
Freisprechen verwenden
Bevor Sie das Mobiltelefon zum ersten Mal mit 
einer Freisprecheinrichtung verbinden, muss 
das Gerät eingeschaltet und betriebsbereit sein 
und sich im Verbindungsmodus bzw. 
Koppelmodus befinden (siehe 
Bedienungsanleitung für das jeweilige Gerät). 
Sie können das Telefon jeweils nur mit einem 
Gerät verbinden.

Zu finden unter: s > u Setup > Verbindungen 
> Bluetooth, drücken Sie Nach Geräten suchen

Auf dem Telefon werden die 
Bluetooth-Audiogeräte angezeigt, die in dessen 
Reichweite gefunden werden.
  1 Blättern Sie zu einem Gerät in der Liste.

2 Drücken Sie s, um eine Verbindung mit 
dem hervorgehoben angezeigten Gerät 
herzustellen.

Dateien zu einem anderen 
Gerät kopieren
Sie können eine Mediadatei, einen Kontakt, 
einen Kalendertermin oder ein Lesezeichen auf 
ein anderes Telefon oder einen Computer 
kopieren, sofern diese Bluetooth unterstützen.

Hinweis: Bestimmte mit einem Kopierschutz 
versehene Objekte können nicht kopiert werden.

Bevor Sie eine Datei auf ein anderes Gerät 
kopieren können, muss das Empfangsgerät 
eingeschaltet und erkennbar sein. Vergewissern 
Sie sich außerdem, dass zu dem Gerät keine 
andere aktive Bluetooth-Verbindung besteht.
  1 Blättern Sie zu dem Objekt, das Sie auf das 

andere Gerät kopieren möchten.

2 Drücken Sie Optionen. Wählen Sie dann:

• Senden an > Bluetooth für eine Bild- oder 
Audiodatei.

• Mitteilen > Kontakt > Bluetooth für einen 
Kontakt.

• Freigeben an > Bluetooth für einen 
Kalendereintrag oder ein Lesezeichen.
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3 Wählen Sie eines der erkannten Geräte aus.

oder

Wählen Sie [Nach Geräten suchen], um nach 
neuen Geräten zu suchen. Wählen Sie 
anschließend das Gerät, auf das Sie das 
Objekt kopieren möchten.

4 Drücken Sie Optionen > Senden.

5 Sofern erforderlich, geben Sie den 
vereinbarten Passkey (z. B. 0000) auf dem 
Telefon und dem Gerät ein, und drücken Sie 
OK, um eine Verbindung zu dem Gerät 
herzustellen.

Während der Datenübertragung wird die 
Meldung Sende auf dem Display Ihres Telefons 
angezeigt. Wenn die Datenübertragung 
abgeschlossen ist, erscheint die Meldung 
Senden erfolgreich, und Sie werden aufgefordert, OK 
zu drücken, um fortzufahren.

Dateien von einem anderen 
Gerät empfangen
Bevor Sie eine Datei von einem anderen Gerät 
empfangen, sollten Sie überprüfen, ob die 

Bluetooth-Funktion Ihres Mobiltelefons 
eingeschaltet ist (siehe Seite 72).

Sobald sich Ihr Mobiltelefon in Reichweite (ca. 
10 m) des anderen Bluetooth-Gerätes befindet, 
kann die Datei von diesem Gerät gesendet 
werden.

Wenn Mobiltelefon und sendendes Gerät bisher 
noch nicht gekoppelt wurden, aktivieren Sie auf 
dem Telefon den Erkennungsmodus, damit es 
vom sendenden Gerät lokalisiert werden kann. 
Drücken Sie s > u Setup > Verbindungen 
> Bluetooth, drücken Sie Optionen 
> Auffindbar: 3 Minuten. Das Bluetooth-Symbol & auf 
dem Standby-Display blinkt, wenn sich das 
Telefon im Erkennungsmodus befindet.

Sie werden vom Telefon benachrichtigt, sobald 
die Datenübertragung abgeschlossen ist. Die 
Datei wird gespeichert.

Foto an einen Drucker 
senden
Sie können ein Foto an einen Drucker senden, 
der Bluetooth-Verbindungen unterstützt.
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Hinweis: Sie können Seiten im Format A4, US 
Letter und 4 x 6 drucken. Wenn Sie in anderen 
Formaten drucken möchten, müssen Sie das 
Bild auf einen verbundenen Computer kopieren 
und über diesen ausdrucken.
  1 Nehmen Sie ein Bild mit dem Mobiltelefon 

auf, oder blättern Sie zu einem 
gespeicherten Bild, das Sie drucken 
möchten, und drücken Sie Optionen 
> Drucken über > Bluetooth.

Hinweis: Wird beim Versuch zu drucken die 
Meldung Unbekannter Dienst angezeigt, so 
wählen Sie stattdessen Senden an > Bluetooth. 
(Bei Verwendung der Option Senden an wird 
kein Bildname oder Zeitstempel gedruckt.)

2 Wählen Sie einen Druckernamen aus der 
Liste, oder drücken Sie Optionen 
> Suche nach Druckern, um nach einem anderen 
Drucker zu suchen, an den Sie das Bild 
senden möchten.

3 Ändern Sie gegebenenfalls die 
Druckoptionen.

Weitere 
Bluetooth-Funktionen
Hinweis: Ein Gerät wird erkannt, nachdem es 
mit dem Mobiltelefon gekoppelt wurde (siehe 
Seite 73).

Funktionen

Mit erkanntem Gerät koppeln

Drücken Sie s > u Setup 
> Verbindungen > Bluetooth und S links, um die 
Registerkarte Meine Geräte auszuwählen. 
Drücken Sie S oben/unten, um zum 
Gerätenamen zu blättern. Drücken Sie dann 
s, um die Verbindung herzustellen.

Verbindung zu dem Gerät trennen

Um die Verbindung zu einem Gerät zu 
trennen, blättern Sie zum Gerätenamen, und 
drücken Sie s.
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Mobiltelefon-Updates
Von Zeit zu Zeit verbessern wir die Software 
Ihres Mobiltelefons, um sie auch nach dem Kauf 
des Telefons schneller und effizienter zu 
gestalten. Unter folgender Adresse können Sie 
nach verfügbaren Updates suchen: 
www.hellomoto.com/update

Hinweis: Software-Updates wirken sich nicht 
auf die Kontaktliste oder andere persönliche 
Einträge oder Dateien aus. Wenn Sie 
empfangene Software-Updates später 
installieren möchten, finden Sie die hierfür 
erforderlichen Informationen auf Seite 89.

Gerät aus der Geräteliste entfernen

Blättern Sie zum gewünschten 
Gerätenamen, und drücken Sie Optionen 
> Verwalten > Gerät entfernen.

Hinweis: Ein Gerät kann nicht aus der 
Geräteliste entfernt werden, solange das 
Telefon mit diesem Gerät verbunden ist.

Während eines Anrufs die 
Audiofunktionen zum 
Bluetooth-Headset oder 
Bluetooth-Autoeinbausatz weiterleiten

Drücken Sie Optionen > Bluetooth verwenden.

Um den Ton wieder auf das Telefon 
umzuleiten, drücken Sie Optionen 
> Mobiltelefon verwenden.

Eigenschaften eines erkannten Geräts 
bearbeiten

Blättern Sie zum gewünschten Gerätenamen, 
und drücken Sie Optionen > Verwalten 
> Gerät bearbeiten.

Funktionen

Optionen für Bluetooth einstellen

Drücken Sie s > u Setup 
> Verbindungen > Bluetooth und Optionen > Verwalten 
> Bluetooth-Setup.

Funktionen
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Spiele (und Applikationen)

Telefonbuch/Text

Schritt 1 Wählen Sie Motorola TEXT oder BACKUP aus 
der Spiele-Liste.

Schritt 2 Wählen Sie Optionen > Start. Wählen Sie 
CREATE A NEW ACCOUNT, und drücken Sie Eingeben.

Schritt 3 Befolgen Sie die Anweisungen auf dem 
Display, um alle Ihre Nachrichten und Kontakte 
zu speichern.

PrizePlay™
Ob Sie Ihre Geschwindigkeit oder Genauigkeit 
testen, neue Welten erforschen oder 
wissenswerte Kleinigkeiten dazulernen 
möchten – PrizePlay hat das richtige Spiel für 
Sie.

Schritt 1 In der Spiele-Liste finden Sie alle 
spannenden PrizePlay-Spiele, die für Ihr 
Motorola-Telefon verfügbar sind.

Schritt 2 Wählen Sie Ihre Sprache in der Liste 
aus, und befolgen Sie die Anweisungen auf dem 
Display.

Schritt 3 Spiel und Spaß mit tollen Gewinnen 
und Spieleguthaben

Achtung: Eventuell werden Gebühren 
erhoben.

Sichern Sie Ihr 
Telefonbuch online. So 
können Sie auch dann 
noch auf Ihre Kontakte 
zugreifen, wenn Sie Ihr 
Motorola-Telefon 
verloren oder 
beschädigt haben.

Ab jetzt können Sie alle 
wichtigen und 
besonderen Nachrichten 
aufheben, selbst wenn 
Ihr Posteingang voll ist.
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Tipp: Guthaben für PrizePlay-Spiele können zu 
einem Aufpreis direkt im Anwendungsmenü 
erworben werden.

Rough Guide®

Auf der Suche nach einem Hotel oder 
Restaurant? Sie kennen sich in der Gegend 
nicht aus? Kein Problem – mit dem Rough 
Guide finden Sie sich schnell zurecht!

Schritt 1 Wählen Sie Rough Guides aus der 
Spiele-Liste.

Schritt 2 Wählen Sie Ihre Sprache in der Liste 
aus, und befolgen Sie die Anweisungen auf dem 
Display.

Schritt 3 Mit der Navigationstaste können Sie 
Ihren Standort auf der Karte markieren und so 
schnell den Weg ans Ziel finden.

Sie wollen mehr?
Weitere Extras für Ihr Telefon finden Sie auf der 
HELLOMOTO-Website.

Wählen Sie im Hauptmenü Ihres Telefons den 
Web-Zugriff, blättern Sie zu Bookmarks, und drücken 
Sie auf den Motorola-Link.
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Sonstige Funktionen

Erweiterte 
Anruffunktionen
Wie Sie zum Anrufen Sprachbefehle verwenden, 
finden Sie auf Seite 30.

Funktionen
Kurzwahl

Sie können neun Rufnummern im Telefon 
speichern, die Sie durch einen einzigen 
Tastendruck anrufen können. So speichern 
Sie eine Kurzwahlnummer:

s > L Kontakte, drücken Sie dann Optionen 
> Einrichten > Kurzwahlliste 
> Kurzwahlspeicherort

Um eine Kurzwahlnummer anzurufen, halten 
Sie einfach die entsprechende Taste eine 
Sekunde lang gedrückt.

Internationale Anrufe

Zur Eingabe einer Rufnummer im 
Ausland (nur möglich, wenn Ihr 
Mobiltelefonvertrag Auslandsgespräche 
zulässt) halten Sie 0 gedrückt, um die 
Auslandsvorwahl (+) einzufügen. Wählen Sie 
dann die Ländervorwahl und die Rufnummer 
mithilfe der Zifferntasten.
Halten eines Anrufs

Zum Halten aller aktiven Gespräche drücken 
Sie Optionen > Halten.
Stummschalten eines Gesprächs

Zum Stummschalten aller aktiven Gespräche 
drücken Sie Optionen > Stumm.

Funktionen
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Hörgerät

Mobiltelefon mit einem Hörgerät im 
Telefonspulen-Modus verwenden:

s > u Setup > Anrufe > Gesprächsoptionen 
> Hörhilfe > Telefonspule ein

Funktionen
Anklopfen

Wenn während eines laufenden 
Gesprächs ein weiterer Anruf eintrifft, werden 
Sie durch den Anklopfton auf diesen zweiten 
Anruf hingewiesen. Drücken Sie zum 
Annehmen des neuen Anrufs N.

• Drücken Sie zum Wechseln zwischen 
den Gesprächen (Makeln) Wechseln.

• Drücken Sie zum Zusammenführen 
der beiden Gespräche Verbinden.

• Zum Beenden des gehaltenen Anrufs 
drücken Sie Optionen 
> Gehaltenen Anruf beenden.

Gehen Sie folgendermaßen vor, um das 
Anklopfen zu aktivieren oder zu deaktivieren:

s > u Setup > Anrufe > Gesprächsoptionen 
> Anklopfen > Ein oder Aus

Funktionen
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Weiteren Anruf während eines Anrufs 
tätigen

Während eines Anrufs:

Optionen > Neuer Anruf, drücken Sie Optionen 
> Kontakte durchsuchen.
Konferenzgespräch

Während eines Anrufs:

Wählen Sie die nächste Nummer, drücken Sie 
N und Optionen > Anrufe verbinden.
Anruf weiterleiten

Während eines Anrufs:

Optionen > Übergabe, wählen Sie die Nummer, an 
die das Gespräch weitergeleitet werden soll, 
und drücken Sie N.
Rufumleitung

Rufumleitung aktivieren oder 
deaktivieren:

s > u Setup > Anrufe > Anrufumleitung

Funktionen
Anrufsperre

Einschränkungen für abgehende oder 
eingehende Anrufe festlegen:

s > u Setup > Anrufe > Anrufsperre
Telefonleitung wechseln

Wenn Sie über eine SIM-Karte mit zwei 
Rufnummern verfügen, können Sie die 
Leitung wechseln, um über Ihre andere 
Rufnummer Anrufe zu tätigen und zu 
empfangen:

s > u Setup > Anrufe > Gesprächsoptionen 
> Aktive Leitung

Das Symbol für die aktive Leitung zeigt die 
aktive Telefonleitung an (siehe Abbildung auf 
Seite 26).

Funktionen

U9.EMEA.Asia.UG.book  Page 81  Friday, January 4, 2008  3:13 PM



82 Sonstige Funktionen – Kontakte

34 Englisch

Kontakte
Die grundlegenden Funktionen der Kontaktliste 
werden in der Kurzanleitung beschrieben.

Feste Rufnummern

Wenn Sie diese Funktion aktivieren, 
können Sie nur die in der Liste der festen 
Rufnummern gespeicherten Rufnummern 
anrufen.

Hinweis: Sie müssen den PIN2-Code für die 
SIM-Karte eingeben, um die Funktion „Feste 
Rufnummern“ ein- oder auszuschalten. 
Setzen Sie sich mit dem Diensteanbieter in 
Verbindung, wenn Sie den PIN2-Code 
vergessen haben.

Aktivieren oder Deaktivieren der Funktion 
"Feste Rufnummern":

s > u Setup > Anrufe > Feste Rufnummern > Ein 
oder Aus

Liste der festen Rufnummern verwenden:

s > m Tools > Wähldienste > Feste Rufnummern
Service-Rufnummer

Vom Diensteanbieter gespeicherte 
Service-Rufnummern wählen:

s > m Tools > Wähldienste > Service-Rufnummer

Funktionen
DTMF-Töne

DTMF-Töne aktivieren:

s > u Setup > Anrufe > Wahl-Setup > DTMF

Zum Versenden von DTMF-Tönen während 
eines Anrufs drücken Sie die Zifferntasten.

Funktionen

Neuen Kontakt hinzufügen

s > L Kontakte, drücken Sie Optionen 
> Kontakt erstellen.

Drücken Sie S links/rechts, um die 
Registerkarten Details w, Adresse u, ID < 
oder Notizen x auszuwählen. Drücken Sie 
S oben/unten, um zu Einträgen zu blättern, 
die Sie ändern möchten. Drücken Sie dann 
s, um diese auszuwählen.

Funktionen
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Kontakt anrufen

s > L Kontakte, blättern Sie zum Kontakt, 
drücken Sie N zum Anrufen.

Hinweis: Wenn ein Kontakt mehrere 
Rufnummern oder E-Mail-Adressen enthält, 
drücken Sie S links/rechts, um die 
gewünschte Nummer oder E-Mail-Adresse 
auszuwählen.

Nachricht an Kontakt senden

s > L Kontakte, blättern Sie zum Kontakt, 
drücken Sie Optionen > Nachricht senden.

Zusätzliche Rufnummer oder E-Mail-Adresse 
zu einem Kontakt hinzufügen

s > L Kontakte, blättern Sie zum Kontakt, 
und drücken Sie Optionen > Bearbeiten. Drücken 
Sie dann S rechts/links, um die 
Registerkarte Details w auszuwählen. 
Drücken Sie S oben/unten, um zu einem 
leeren Zahlen- oder E-Mail-Feld zu blättern. 
Drücken Sie anschließend s, um dieses 
auszuwählen.

Funktionen

Bild-ID für einen Kontakt festlegen

Ein Foto oder Bild zuweisen, das angezeigt 
wird, wenn der betreffende Kontakt anruft:

s > L Kontakte, blättern Sie zum Kontakt. 
Drücken Sie dann Optionen > Bearbeiten. Drücken 
Sie S links/rechts, um die Registerkarte ID 
< auszuwählen. Drücken Sie anschließend 
S oben/unten, um zu Bild-ID: zu blättern. 
Drücken Sie dann s, um diese ID 
auszuwählen.

Rufton-ID für einen Kontakt festlegen

Eindeutiges Anrufsignal (Rufton-ID) für einen 
Kontakt festlegen:

s > L Kontakte, blättern Sie zum Kontakt. 
Drücken Sie dann Optionen > Bearbeiten. Drücken 
Sie S links/rechts, um die Registerkarte ID 
< auszuwählen. Drücken Sie anschließend 
S oben/unten, um zu Signal-ID zu blättern. 
Drücken Sie dann s, um diese ID 
auszuwählen.

Funktionen
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Kontakt einer Kategorie zuweisen

s > L Kontakte, blättern Sie zum Kontakt, 
und drücken Sie Optionen > Bearbeiten. Drücken 
Sie dann S rechts/links, um die 
Registerkarte Details w auszuwählen. 
Drücken Sie S oben/unten, um zu einer 
Kategorie: zu blättern. Drücken Sie anschließend 
s, um diese auszuwählen.

Kategorieansicht anzeigen

s > L Kontakte, drücken Sie Optionen 
> Filtern nach.

Sie können Kontakte in einer vordefinierten 
Kategorie (Alle Kontakte, E-Mail, Geschäftlich, Allgemein, 
Persönlich, Kategorie erstellen) oder die Kontakte in 
einer von Ihnen erstellten Kategorie anzeigen 
(wählen Sie dazu Kategorie erstellen).

Mailing-Liste erstellen

Kontakte einer Gruppennachrichtenliste oder 
E-Mail-Liste zuweisen:

s > L Kontakte, drücken Sie Optionen 
> Liste erstellen > Nachricht oder E-Mail.

Funktionen

Kontaktfotos anzeigen

Kontakte mit Bild-ID oder als Textliste 
anzeigen:

s > L Kontakte, drücken Sie Optionen 
> Einrichten > Standardansicht > Thumbnail oder Liste.

Sortierreihenfolge der Kontaktliste festlegen

s > L Kontakte, drücken Sie Optionen 
> Stand.-Sortierreihenf. > Vorname oder Nachname.

Private Kontakte erstellen und verwenden

Einen oder mehrere Kontakte als private 
Kontakte kennzeichnen. Geben Sie den 
sechsstelligen Sicherheitscode ein, um auf 
die privaten Kontakte in Ihrer Kontaktliste 
zugreifen zu können.

s > L Kontakte, drücken Sie Optionen 
> Einrichten > Private Kontakte.

Funktionen
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Kontakte in den Telefonspeicher importieren

Alle Kontakte von der SIM-Karte oder von 
einem anderen Speicherort in den 
Telefonspeicher importieren:

s > L Kontakte, drücken Sie Optionen 
> Kontakte imp. > SIM-Karte oder Datei-Manager.

Kontakte auf SIM-Karte verwalten

s > L Kontakte, drücken Sie Optionen 
> Einrichten > SIM-Karten-Manager.

Kontakte von der SIM-Karte löschen oder 
vom Telefonspeicher oder einem anderen 
Speicherort auf die SIM-Karte importieren:

Funktionen

Kontakte an ein anderes Gerät senden

Einen oder mehrere Kontakte an ein anderes 
Telefon, einen Computer oder ein anderes 
Gerät senden:

s > L Kontakte, blättern Sie zum Kontakt. 
Drücken Sie dann Optionen > Mitteilen und 
anschließend s, um den aktuellen Kontakt 
auszuwählen. Drücken Sie dann S 
oben/unten, um zur Übertragungsmethode 
Bluetooth, Messaging oder E-Mail zu blättern. 
Drücken Sie Auswählen, um diese auszuwählen.

Um mehrere Kontakte zu senden, drücken Sie 
Optionen > Mitteilen > Mehrere Kontakte (anstelle des 
aktuellen Kontakts).

Funktionen
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Personalisieren

Kontakte löschen

Einen oder mehrere Kontakte von Ihrer 
Kontaktliste löschen.

s > L Kontakte, blättern Sie zum Kontakt. 
Drücken Sie dann Optionen > Löschen und 
anschließend s, um den aktuellen Kontakt 
auszuwählen. Drücken Sie Ja, um den 
Löschvorgang zu bestätigen.

Um mehrere Kontakte zu löschen, drücken 
Sie Optionen > Löschen > Mehrere Kontakte (anstelle 
des aktuellen Kontakts).

Funktionen

Sprache

Menüsprache festlegen:

s > u Setup > Telefon > Sprache

Funktionen

Erinnerungen

Erinnerungssignal für 
Terminbenachrichtigungen festlegen:

s > u Setup > Profile, drücken Sie S 
links/rechts, um die Registerkarte 
Einstellungen #, > Erinnerungssignal 
auszuwählen.

Einstellungen zurücksetzen

Zurücksetzen aller Optionen auf ihre 
werkseitigen Einstellungen, mit Ausnahme 
von Entsperrcode, Sicherheitscode und 
Lebenszeit-Timer:

s > u Setup > Telefon > Zurücksetzen 
> Alle Einst. zurückset.

Funktionen
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34 Englisch

Gesprächsdauer und 
-gebühren
Die Netzverbindungszeit ist die Zeit, die 
zwischen dem Herstellen der Verbindung zum 
Netz und dem Beenden der Verbindung durch 
Drücken von O liegt. Dazu gehören auch 
Besetztzeichen und Klingeltöne.

Daten löschen

Hinweis: Diese Option löscht alle von Ihnen 
eingegebenen Daten (einschließlich Kontakte 
und Kalendereinträge) sowie alle 
heruntergeladenen Inhalte im Speicher des 
Mobiltelefons (einschließlich Fotos und 
Sounddateien). Diese Daten können nach 
dem Löschen nicht wiederhergestellt werden.

Mit dieser Option werden die Daten auf der 
SIM-Karte nicht gelöscht:

s > u Setup > Telefon > Zurücksetzen 
> Alle Daten löschen

Funktionen

Daten auf der Speicherkarte löschen

Hinweis: Mit dieser Option werden alle von 
Ihnen eingegebenen Daten gelöscht 
(einschließlich Kontakte und 
Kalendereinträge) sowie alle Daten, die auf 
die Speicherkarte und/oder SIM-Karte des 
Mobiltelefons heruntergeladen wurden 
(einschließlich Fotos und Sounddateien). 
Diese Daten können nach dem Löschen nicht 
wiederhergestellt werden.

s > u Setup > Telefon > Zurücksetzen 
> Speicherkarte löschen

Funktionen
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34 Englisch
Eventuell stimmt die Zeit, die Sie mit 
zurücksetzbaren Timern erfassen, nicht mit der 
Verbindungsdauer überein, die Ihnen von dem 
Diensteanbieter berechnet wird. Wenn Sie 
Informationen zu Ihrer Abrechnung benötigen, 
wenden Sie sich an Ihren Diensteanbieter.

Freisprecheinrichtungen
Hinweis: Die Benutzung von Mobiltelefonen 
kann beim Führen eines Kfz Ablenkungen 
verursachen. Es ist daher untersagt, während 
des Fahrens zu telefonieren. Außerdem ist die 
Verwendung von drahtlosen Geräten und deren 
Zubehör in bestimmten Umgebungen unter 

Funktionen

Gesprächszeiten

Gesprächstimer anzeigen:

s > q Anrufliste, drücken Sie Optionen 
> Gesprächszeit.

Gesprächstimer

Anrufzeit während eines Anrufs 
anzeigen:

s > u Setup > Anrufe > Gesprächsoptionen 
> Gesprächstimer

Gesprächsgebühren

Gebührenzähler und 
Guthabeninformationen anzeigen:

s > q Anrufliste, drücken Sie Optionen 
> Anrufkosten.

Guthabenlimit

Guthaben einstellen:

s > q Anrufliste, drücken Sie Optionen 
> Anrufkosten > Anrufkosten-Setup.

GPRS-Zeitmesser

Datenruf-Timer anzeigen:

s > q Anrufliste, drücken Sie Optionen 
> Datenzeiten.

GPRS-Datenzähler

Datenmengenzähler anzeigen:

s > q Anrufliste, drücken Sie Optionen 
> Datenmengen.

Funktionen
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34 Englisch
Umständen verboten. Die Gesetze und 
Vorschriften zur Nutzung dieser Produkte 
müssen stets eingehalten werden.

Netz

Funktionen

Automatische Rufannahme (Headset)

Automatische Rufannahme, wenn ein 
Autoeinbausatz oder Headset angeschlossen 
ist:

s > u Setup > Telefon > Headset-Einst. 
> Auto-Antwort

Sprachwahl (Headset)

Sprachwahl mit der Sende-/Endetaste 
des Headsets aktivieren:

s > u Setup > Telefon > Headset-Einst. 
> Sprachwahl

Funktionen

Netzeinstellungen

Netzinformationen anzeigen und 
Netzeinstellungen anpassen:

s > u Setup > Netz

Software-Update

Ihr Diensteanbieter kann 
Software-Updates über das Mobilfunknetz an 
Ihr Telefon senden. Wenn Sie ein Update mit 
dem Telefon empfangen, können Sie es sofort 
installieren oder die Installation auf einen 
späteren Zeitpunkt verschieben. So 
installieren Sie ein Software-Update zu einem 
späteren Zeitpunkt:

s > u Setup > Telefon > OTA-Updates 
> Software aktual.
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34 Englisch

Tools
Funktionen

Weckfunktion einstellen

s > A Wecker

Schnellzugriff: Drücken Sie Schn.tast. 
> Alarm einstellen auf dem Standby-Display.

Alarm ausschalten

Auf dem Display wird ein Alarm angezeigt: 

Drücken Sie zum Abschalten des Alarmtons 
Ablehnen oder O.

Um den Alarmton für acht Minuten 
stummzuschalten, drücken Sie Erneut erinnern.

Standardansicht des Kalenders einstellen

s > m Tools > Kalender, drücken Sie Optionen 
> Kalender-Setup > Standardansicht.

Neuen Kalendertermin hinzufügen

s > m Tools > Kalender, wählen Sie Tag 
und/oder Startzeit aus. Drücken Sie s, und 
geben Sie die Termindetails ein.

Sie können sich mit einer Musik- oder 
Audiodatei, einer Sprachaufnahme oder 
einem Videoclip an einen Termin erinnern 
lassen. Wenn Sie einen Kalendertermin 
erstellen, wählen Sie Alarmstil: > Signaltyp, 
blättern Sie zu der Datei (oder erstellen Sie 
eine neue Datei), drücken Sie Einfügen.

Kalendertermin anzeigen

s > m Tools > Kalender > Termin

Um die Termindetails zu bearbeiten, drücken 
Sie Optionen > Bearbeiten.

Funktionen
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34 Englisch

Terminerinnerung

Auf dem Display wird eine Terminerinnerung 
angezeigt und ein Signal dafür ausgegeben:

Wählen Sie Termin öffnen, um die Details der 
Erinnerung anzuzeigen.

Drücken Sie Ablehnen, um die Erinnerung zu 
schließen.

Kalendereintrag an ein anderes Gerät senden

Kalendertermin an ein anderes Mobiltelefon, 
einen Computer oder ein anderes Gerät 
senden:

s > m Tools > Kalender > Termin, drücken 
Sie Optionen > Freigeben an > Bluetooth oder 
Nachricht.

Heruntergeladene Dateien verwalten

Dateien und Anwendungen verwalten, die Sie 
vom Browser über eine 
Bluetooth®-Verbindung auf das Telefon 
heruntergeladen haben:

s > m Tools > Download-Manager

Funktionen

Weltuhr

Uhrzeit und Datum für mehrere Städte in der 
ganzen Welt anzeigen:

s > m Tools > Weltuhr

Aufgabenliste

Checkliste für anstehende Aufgaben erstellen 
und das Telefon für die Benachrichtigung von 
fälligen Aufgaben einrichten:

s > m Tools > Aufgabenliste

Notizen

Notizen auf dem Telefon schreiben und 
speichern:

s > m Tools > Notizen

Funktionen
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34 Englisch

Sicherheit

Sprachaufzeichnung

s > j Multimedia > Voice Recorder, drücken Sie 
s, um die Aufzeichnung zu starten. Drücken 
Sie Stopp, um die Aufzeichnung zu beenden.

Um die Sprachaufzeichnung zu speichern, 
drücken Sie Speichern.

Drücken Sie Optionen, um weitere Funktionen 
für die Sprachaufzeichnung auszuführen.

Hinweis: Die Aufzeichnung von Gesprächen 
unterliegt unterschiedlichen 
Datenschutzgesetzen. Die Gesetze und 
Vorschriften zur Nutzung dieser Funktion 
müssen stets eingehalten werden.

Sprachaufzeichnung abspielen

So starten Sie die Wiedergabe einer 
Sprachaufzeichnung:

s > j Multimedia > Media Finder > Sprachmemo 
> Sprachaufzeichnung

Rechner

s > m Tools > Rechner

Funktionen

Währungsumrechner

s > m Tools > Rechner, drücken Sie Optionen 
> Wechselkurs einstellen, geben Sie den 
Wechselkurs ein, drücken Sie Einstellen, geben 
Sie den Betrag ein, und drücken Sie Optionen 
> Währung umwandeln.

Funktionen

PIN-Code der SIM-Karte

Hinweis: Wenn Sie drei Mal hintereinander 
einen falschen PIN-Code eingeben, wird Ihre 
SIM-Karte gesperrt und folgende Meldung auf 
dem Display angezeigt SIM gesperrt.

SIM-Karte sperren oder entsperren:

s > u Setup > Sicherheit > SIM-PIN

Sperren von Anwendungen

s > u Setup > Sicherheit > Anwendungssperre

Funktionen
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34 Englisch

Spaß und Spiel

Zertifikate verwalten

Im Telefon gespeicherte Zertifikate für 
den Internet-Zugriff aktivieren oder 
deaktivieren:

s > u Setup > Sicherheit > Zertifikate

Zertifikate ermöglichen Ihnen, beim 
Herunterladen von Dateien oder bei der 
Freigabe von Informationen die Identität und 
Sicherheit von Websites zu prüfen.

Funktionen

Spiel oder Anwendung starten

JAVA™-Spiel oder –Anwendung 
starten:

s > T Spiele > Spiel oder Anwendung

Funktionen

Flugzeugmodus

Schalten Sie die Anruffunktionen des Telefons 
an Orten aus, wo Mobiltelefone verboten 
sind. Mit dieser Option können Sie den 
Musik-Player und andere Funktionen, die 
nicht vom Netz abhängig sind, verwenden, 
wenn Sie sich in einem Flugzeug befinden, 
ohne die Kommunikationseinrichtungen des 
Flugzeugs zu stören.

s > u Setup > Telefon > Flugzeugmodus > Ein

Schalten Sie den Flugzeugmodus aus, um die 
Anruffunktionen des Telefons wieder zu 
aktivieren.

Funktionen

U9.EMEA.Asia.UG.book  Page 93  Friday, January 4, 2008  3:13 PM



94 SAR-Daten

SAR-DatenDaten zur spezifischen Absorptionsrate

DIESES TELEFONMODELL ENTSPRICHT DEN 
INTERNATIONALEN RICHTLINIEN FÜR DIE 
BEGRENZUNG DER EXPOSITION DURCH 
ELEKTROMAGNETISCHE FELDER
Ihr Mobiltelefon ist ein Radiosender und 
-empfänger. Es ist so konzipiert, dass die 
international empfohlenen Höchstwerte für die 
Belastung durch elektromagnetische Felder nicht 
überschritten werden. Diese Richtlinien wurden 
von einer unabhängigen wissenschaftlichen 
Organisation, der ICNIRP, erarbeitet und 
beinhalten Sicherheitsfaktoren, die den Schutz 
aller Personen unabhängig von Alter und 
Gesundheitszustand sicherstellen.
Die Richtlinien verwenden eine Maßeinheit, die 
als SAR (Specific Absorption Rate) oder 
spezifische Absorptionsrate bezeichnet wird. Die 
von der ICNIRP festgelegte SAR-Höchstgrenze 
(ICNIRP SAR) für Mobilfunkgeräte beträgt für die 
allgemeine Bevölkerung 2 W/kg. Der höchste 
SAR-Wert, der bei Prüfungen mit diesem Gerät am 
Ohr gemessen wurde, betrug 1,02 W/kg1. Da 
Mobilfunkgeräte die verschiedensten Funktionen 
bereitstellen, können sie auch an anderen 
Betriebspositionen verwendet werden, 
beispielsweise am Körper2 (siehe 
Bedienungsanleitung). In diesem Fall betrug der 
höchste gemessene SAR-Wert 0,41 W/kg1.

Da der SAR-Wert bei der maximalen 
Sendeleistung des Mobilfunkgeräts gemessen 
wird, liegt der tatsächliche SAR-Wert für dieses 
Gerät während des Betriebs typischerweise unter 
dem genannten Wert. Das ist darauf 
zurückzuführen, dass die Sendeleistung des 
Geräts automatisch auf den geringst möglichen 
Wert eingestellt wird, der erforderlich ist, um das 
Netzwerk zu erreichen. 
SAR-Werte für verschiedene Telefone und 
Bedienpositionen können voneinander 
abweichen. Sie entsprechen jedoch alle den 
behördlichen Anforderungen für einen sicheren 
Betrieb. Bitte beachten Sie, dass technische 
Weiterentwicklungen an diesem Modell zu 
veränderten SAR-Werten für neuere Produkte 
führen können. In allen Fällen genügen die SAR-
Werte aber den Anforderungen der Richtlinien.
Nach Einschätzung der 
Weltgesundheitsorganisation (WHO) sind nach 
dem gegenwärtigen Stand der Wissenschaft keine 
besonderen Vorsichtsmaßnahmen für den Betrieb 
von Mobilfunkgeräten erforderlich. Um die 
Belastung zu verringern, empfiehlt sie, die Dauer 
von Gesprächen zu begrenzen und/oder 
Freisprecheinrichtungen einzusetzen, um einen 
möglichst großen Abstand zwischen 
Mobilfunkgerät und Kopf bzw. Körper einzuhalten. 
Weitere Informationen hierzu finden Sie auf den 
Websites der Weltgesundheitsorganisation 
(http://www.who.int/emf) und von Motorola, 
Inc. (http://www.motorola.com/rfhealth).
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1. Die Tests wurden in Übereinstimmung mit 
internationalen Prüfrichtlinien durchgeführt. Der 
Höchstwert enthält einen erheblichen 
Sicherheitsfaktor als zusätzlichen Schutz für die 
Bevölkerung und zur Berücksichtigung von 
möglichen Messabweichungen. Weitere 
Informationen hierzu finden Sie im Motorola 
Testprotokoll sowie den Unterlagen zum 
Beurteilungsverfahren und zur 
Messfehlergenauigkeit für dieses Produkt.

2. Bitte beachten Sie für den körpernahen Betrieb 
den Abschnitt Sicherheitsrelevante und 
allgemeine Informationen
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if WHO-InformationenInformationen der WHO 
(Weltgesundheitsorganisation)

Derzeitige wissenschaftliche Studien lassen 
keinerlei Notwendigkeit für spezielle 
Vorsichtsmaßnahmen bei der Verwendung von 
Mobiltelefonen erkennen. Wenn Sie sich und Ihre 
Kinder vor Funkfrequenzemissionen schützen 
wollen, können Sie die Anrufdauer beschränken 
oder Freisprecheinrichtungen verwenden, um den 
Abstand zwischen Kopf bzw. Körper und Telefon 
zu vergrößern.
Quelle: WHO Fact Sheet 193
Weitere Informationen: 
http://www.who.int./peh-emf
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XXX English

Privatsphäre und Datenschutz
Privatsphäre und DatenschutzMotorola ist sich der Bedeutung der Privatsphäre 
und des Datenschutzes bewusst. Da sich einige 
Funktionen Ihres Mobilgeräts auf Ihre Privatsphäre 
oder den Schutz Ihrer Daten auswirken können, 
befolgen Sie diese Empfehlungen, um den Schutz 
Ihrer persönlichen Daten zu verbessern:

• Kontrollieren Sie den Zugriff – Behalten 
Sie Ihr Mobilgerät bei sich, und lassen Sie 
es nicht dort, wo andere unkontrolliert 
darauf zugreifen können. Sperren Sie die 
Tasten Ihres Geräts, wenn diese Funktion 
verfügbar ist.

• Halten Sie die Software auf dem 
neuesten Stand – Wenn Motorola oder 
ein Software-/Anwendungsanbieter einen 
Patch oder Softwarefix für Ihr Mobilgerät 
veröffentlicht, mit dem die Sicherheit des 
Geräts auf den neuesten Stand gebracht 
wird, installieren Sie ihn so bald wie 
möglich.

• Löschen Sie Daten vor dem Recycling – 
Löschen Sie persönliche Informationen 
oder Daten von Ihrem Mobilgerät, bevor 
Sie es entsorgen oder zum Recycling 
abgeben. Schritt-für-Schritt-Anleitungen 
zum Löschen aller persönlichen 
Informationen von Ihrem Gerät finden Sie 
in den Abschnitten „Zurücksetzen und 
Löschen“ oder „Daten löschen“ in dieser 
Bedienungsanleitung.
Hinweis: Informationen zum Sichern 
der Daten Ihres Mobilgeräts vor dem 

Löschen finden Sie unter 
www.motorola.com. Navigieren Sie zum 
Abschnitt „Downloads“ der Webseite 
„Consumer“ und dann zu „Motorola 
Backup“ oder „Motorola Phone 
Tools“.

• Befassen Sie sich mit AGPS – Um die 
FCC-Anforderungen bei der 
Positionsbestimmung für Notrufe in den 
USA zu erfüllen, ist in bestimmte 
Motorola Mobilgeräte die AGPS-
Technologie (Assisted Global Positioning 
System) integriert. AGPS-Technologie 
kann, auch wenn kein Notfall vorliegt, mit 
bestimmten Anwendungen dazu genutzt 
werden, die Position eines Benutzers zu 
verfolgen und zu kontrollieren – z. B. für 
Fahrtrichtungsangaben. Benutzer, die 
diese Verfolgung und Kontrolle nicht 
zulassen möchten, sollten die Nutzung 
solcher Anwendungen vermeiden.

Wenn Sie weitere Fragen dazu haben, wie die 
Nutzung Ihres Mobilgeräts sich auf Ihre 
Privatsphäre oder den Schutz Ihrer Daten 
auswirken kann, wenden Sie sich unter 
privacy@motorola.com an Motorola, oder setzen 
Sie sich mit Ihrem Dienstanbieter in Verbindung.
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XXX English

Vorsichtsmaßnahmen beim Autofahren
Fahrsicherheit Drive Safe, Call Smart SM

Informieren Sie sich über die Gesetze und 
Bestimmungen zur Nutzung von Mobilgeräten 
und deren Zubehör in den Regionen, in denen Sie 
mit dem Fahrzeug unterwegs sind. Halten Sie 
sich immer an diese Gesetze und Bestimmungen. 
Der Einsatz dieser Geräte ist in einigen Regionen 
eventuell verboten oder nur eingeschränkt 
erlaubt. Weitere Informationen finden Sie unter 
www.motorola.com/callsmart.
Ihr Mobilgerät ermöglicht Ihnen Gespräche und 
Datenaustausch – nahezu überall und jederzeit 
dort, wo drahtlose Dienste verfügbar sind und 
sichere Bedingungen es zulassen. Beim Führen 
eines Fahrzeugs sind Sie zuallererst für das Fahren 
verantwortlich. Wenn Sie Ihr Mobilgerät – soweit 
gesetzlich erlaubt – beim Fahren nutzen möchten, 
beachten Sie die folgenden Tipps:

• Machen Sie sich mit Ihrem Motorola 
Mobilgerät und seinen Funktionen wie 
Kurzwahl und Wahlwiederholung 
vertraut. Die Nutzung dieser Funktionen 
ermöglicht es Ihnen, Ihr Mobilgerät zu 
nutzen, ohne dass Ihre Aufmerksamkeit 
vom Verkehr abgelenkt wird.

• Benutzen Sie, falls möglich, 
eine Freisprecheinrichtung. 
Machen Sie Ihr Mobilgerät 
nach Möglichkeit noch 
komfortabler mit einer der 
zahlreichen Motorola Original-
Freisprecheinrichtungen, die aktuell 
erhältlich sind.

• Legen Sie Ihr Mobilgerät in greifbarer 
Nähe ab. Sie müssen Ihr Mobilgerät in die 
Hand nehmen können, ohne den Blick 
vom Verkehr abzuwenden. Wenn Sie zu 
einem ungünstigen Zeitpunkt einen Anruf 
erhalten, lassen Sie ihn nach Möglichkeit 
von der Mailbox beantworten.

• Informieren Sie Ihren Gesprächspartner, 
dass Sie mit dem Fahrzeug unterwegs 
sind; und beenden Sie erforderlichenfalls 
das Gespräch, wenn der Verkehr zu stark 
oder das Wetter zu schlecht ist. Regen, 
Schneeregen, Schnee, Eis und selbst ein 
starkes Verkehrsaufkommen können 
gefährlich sein.

• Machen Sie sich beim Fahren keine 
Notizen, und schauen Sie keine 
Rufnummern nach. Rasch eine Merkliste 
aufzuschreiben oder das Adressbuch 
durchzublättern lenkt Sie von Ihrer 
Hauptverantwortlichkeit im Verkehr ab – 
dem sicheren Fahren.
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XXX English
• Passen Sie Ihr Verhalten beim Wählen 

der Verkehrslage an; rufen Sie nach 
Möglichkeit an, wenn Ihr Fahrzeug steht 
oder bevor Sie losfahren. Wenn Sie 
während der Fahrt anrufen müssen, 
wählen Sie jeweils nur wenige Zahlen, 
schauen Sie umgehend wieder auf die 
Straße und in die Spiegel, und wählen Sie 
erst dann weiter.

• Führen Sie keine anstrengenden oder 
emotionalen Gespräche, die Sie 
ablenken können. Machen Sie Ihren 
Gesprächspartnern deutlich, dass Sie mit 
dem Fahrzeug unterwegs sind, und 
beenden Sie Gespräche, die Sie vom 
Verkehr ablenken können.

• Nutzen Sie Ihr Mobilgerät für Notrufe. 
Wählen Sie 112 oder eine andere 
regionale Notrufnummer bei einem 
Brand, Verkehrsunfall oder medizinischen 
Notfall.*

• Nutzen Sie Ihr Mobilgerät, um anderen 
in Notfällen zu helfen. Wenn Sie Zeuge 
eines Verkehrsunfalls, einer Straftat oder 
eines anderen schweren Notfalls werden, 
bei dem Lebensgefahr besteht, wählen 
Sie 112 oder eine andere regionale 
Notrufnummer – wie Sie es von anderen 
erwarten würden, wenn Sie in Not 
wären.*

• Rufen Sie erforderlichenfalls den 
Pannendienst oder eine andere 
besondere Mobilfunknummer für 
Hilfestellung, die nicht für Notfälle 
zuständig ist, an. Wenn Sie ein liegen 
gebliebenes Fahrzeug sehen, das keine 
ernsthafte Gefahr darstellt, eine defekte 

Ampel, einen kleineren Verkehrsunfall, 
bei dem niemand verletzt zu sein scheint, 
oder ein Fahrzeug, das Ihres Wissens 
gestohlen wurde, rufen Sie den 
Pannendienst oder eine andere 
besondere Mobilfunknummer, die nicht 
für Notfälle zuständig ist, an*.

* Überall dort, wo ein Mobiltelefondienst verfügbar 
ist.
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34 Englisch
Informationen zu OSSINFORMATIONEN ZU OPEN SOURCE 
SOFTWARE

Um Informationen zu erhalten, wie Sie eine 
Kopie der von Motorola öffentlich zur Verfügung 
gestellten Quellcodes erhalten können, die in 
der Software dieses Mobiltelefons von Motorola 
verwendet werden, senden Sie eine schriftliche 
Anfrage an:

MOTOROLA, INC.
OSS Management
600 North US Hwy 45
Libertyville, IL 60048
USA

Die Website opensource.motorola.com von 
Motorola enthält ebenfalls Informationen über 
die Verwendung von Open Source durch 
Motorola.
Die von Motorola erstellte Website 
opensource.motorola.com soll als Portal zur 
Interaktion mit der Software-Community dienen.
Um weitere Informationen zu Lizenzen, 
Bestätigungen und erforderlichen 
Urheberrechtshinweisen für Open 
Source-Pakete zu erhalten, die in diesem 
Mobiltelefon von Motorola enthalten sind, 
wählen Sie unter Telefon den Eintrag Rechtliche 
Hinweise aus.
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abc-Modus  28
Akku  20
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Auflösung  56
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Autoeinbausatz  88

B
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C
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D
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43
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86
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Synchronisieren  67

E-Mail-Adresse  82
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Entsperrcode  33, 34
Entsperrcode eingeben 

(Meldung)  33
Entsperren

Anwendung  92
Externe Tasten  33
Mobiltelefon  33
SIM-Karte  92
Telefon  34

Entwurfsordner  63
Erinnerungen  86
Externes Display  3, 30

F
Feste Rufnummer  82
Flugzeugmodus  32, 93
Foto  53
Freisprechfunktion  3, 33
Freisprech-Lautsprecher  88

G
Gebührenzähler  88
Gespräch (Symbol)  26
Gesprächstimer  88
Gewählte Rufnummern  42

GPRS-Symbol  25

H
Halten eines Anrufs  79
Headset  88
Helligkeit  40
Hörgerät  80
Hörmuschellautstärke  29, 30

I
IM  65
IM-Anzeigen  25
IM-Symbole  25
Instant Messaging. Siehe IM

K
Kabel verwenden  70
Kalender

Ansicht einstellen  90
Senden, Termin  91
Synchronisieren  67, 68
Termin hinzufügen  90

Kamera  3, 53, 57
Kein Signal, Profil  35
Klappe  30, 41

Klingelton-ID  43
Klingeltonlautstärke einstellen  

35, 36
Konferenzgespräch  81
Kontakte filtern  84
Kontaktliste

Ansicht  84
Bild-ID  43
Eintrag hinzufügen  82
Filter  84
Kontakt senden  85
Synchronisieren  67, 68

Koppeln. Siehe Bluetooth- 
Verbindungen

Kurzwahl  79

L
Lautstärke  29, 35, 36
Lautstärketasten  3, 29
Löschen-/Rücktaste  27

M
Mailing-Liste  84
Medienlautstärke einstellen  

35, 36
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Medienwiedergabe  35, 36
Menü  4, 24
Menüsymbole  24
Menütaste  19
Micro-USB-Anschluss  3, 20, 

70
Mittlere Taste  19
MMS herunterladen  65
MMSIM-Karte  22, 23
MMS-Nachricht  62, 64
MOTOSYNC  67, 68
MP3-Sounddateien  46
Musik-Player  46

N
Nachricht

Gelesen  64
Lesen  63
Senden  62

Nachrichten. Siehe IM
Nachrichtenerinnerungen  86
Nachrichtensymbol  25, 63
Navigationstaste  19
Netzeinstellungen  89
Niedriger Akkustand 

(Meldung)  26

Notizen  91
Notrufnummer  44
Numerischer Modus  29

O
Optionale Funktion  19
Optionale Funktionen  19
Optionales Zubehör  19

Ö
Öffnen zum Annehmen eines 

Anrufs  41

P
Passwörter Siehe Codes
Personalisieren  86
PIN2-Code  33, 82
PIN-Code  33, 92
Positionsanzeige  25
PrizePlay™  77
Profilanzeige  26
Profile  26, 35

R
Rechner  92

Rough Guide®  78
Rufnummer

Eigene Nummer  81
Speichern  82

Rufnummer wählen  82
Rufnummern speichern  82
Rufton-ID  83
Rufumleitung  81
Rufumleitung (Symbol)  26

S
safety tips  98
Screensaver  38, 41
Seitliche Auswahltaste  3, 30
Service-Rufnummer  82
Sicherheitscode  33
Signal

Ausschalten  29, 42
Einstellen  30, 35, 38

Signalprofil  35
Signalstärkeanzeige  25
Signalton  35, 38, 50
Signaltyp  30
Signaltyp-Profile  26
SIM gesperrt (Meldung)  92
SIM-Karte  33, 82, 92
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SIM-Karte, Daten löschen  87
Skin  38
Smart-Taste  30
Softkeys  24
Software-Update  76, 89
Speicherkarte  69
Sperren

Anwendung  92
Externe Tasten  33
SIM-Karte  92
Telefon  34

Sprachaufzeichnung  92
Sprachbefehle  30
Sprachbefehltaste  3, 31
Sprache  86
Sprachnachrichten  44
Sprachnachricht-Symbol  44
Sprachwahl  30, 89
Standby-Display  4, 24
Stummschalten eines Anrufs  

79
Stummschaltung  30
Symbol-Eingabemodus  29
Synchronisieren  67, 68

T
Tastatur  41
Tastaturlautstärke einstellen  

35, 36
Telefonbuch/Text  77
Text bearbeiten  27
Text löschen  27
Texteingabe  26
Texteingabemodus  28
Textnachricht  62
Textnachrichten  62
Textvorlage  64
Textvorlagen  64
Theme  38
Timer  88

U
Uhrzeit  37
USB-Kabel  70

V
Verbinden. Siehe Bluetooth- 

Verbindungen
Vereinfachte Worteingabe  27

Verpasste Anrufe (Meldung)  
43

Vibrationsmodus  30
Vibrationsprofil  35
Video  57
Videoblog  58

W
Wahlwiederholung  43
Wallpaper  38
WAP-Seiten  51
Wählen einer Rufnummer  82
Wecker  90
Weltuhr  91
WHO-Informationen  96
Wort-, Texteingabemodus  27

Z
Zertifikatverwaltung  93
Zubehör  19, 72, 88
Zurückrufen  43
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